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1. Инсталляция ClearQuest
Эта глава описывает, как установить ClearQuest. Вы, как администратор ClearQuest, устанавливаете базы данных для использования с ClearQuest, инсталлируете ClearQuest и предоставляете требуемую установочную информацию каждому пользователю клиента. После этого Вы (или ваши пользователи клиентов) можете устанавливать ClearQuest на клиентских машинах.
Важно, чтобы Вы сделали обзор всех необходимых шагов перед началом инсталляции.
Эта глава освещает следующие темы:
· “Перед началом”
“Понятие процесса инсталляции”
Перед началом

Прежде, чем Вы начнете инсталлировать ClearQuest, прочитайте следующее:
· Примечания к выпуску Rational ClearQuest: файл HTML, который содержит самую свежую информацию о системных требованиях (включая поддержку версий платформы).
· На Windows: <d>:\ClearQuest\readme.htm (где <d> - ваш драйвер CD-ROM)
· На Unix: <d>:/products/ClearQuestClient/readme.htm (где <d> - ваш драйвер CD-ROM)
· Введение в Rational ClearQuest: краткий обзор компонентов ClearQuest и их использования.
Администрирование Rational ClearQuest: руководство о том, как настраивать ClearQuest для удовлетворения ваших потребностей.
Примечание: Если Вы используете Rational ClearQuest/TeamTest Edition, см. руководство Getting Started with Rational ClearQuest TeamTest. Это руководство доступно как документ в формате PDF в каталоге \\ClearQuest\books.
Понятие процесса инсталляции

При инсталляции ClearQuest необходимо выполнить следующие шаги:
1. Установить вашу программу базы данных. Как администратор ClearQuest, Вы ответствены за установку баз данных, которую ваши пользователи будут использовать с ClearQuest. См. главу “Конфигурирование баз данных поставщика” на странице 8.

2. Инсталлировать ClearQuest на рабочей станции администратора и создать базы данных ClearQuest. См. главу “Инсталляция ClearQuest для администратора” на странице 21.

Инсталляция ClearQuest для администратора включает следующие шаги:
· “Инсталляция ClearQuest для администратора” на странице 21
· “Создание баз данных ClearQuest” на странице 21
· “Установка интеграции с конфигурационныс управлением” на странице 23
· “Установка представления записей через электронную почту” на странице 26
· “Инсталляция Crystal Reports” на странице 26
3. Установить ваш сервер лицензии. См. главу “Лицензирование ClearQuest” на странице 48.

4. Если нужно, настроить вашу инсталляцию. См. руководство Администрирование Rational ClearQuest для получения подробной информации относительно настройки ClearQuest.

5. Инсталлировать ClearQuest на клиентских машинах и обеспечить пользователей информацией, нужной для соединения с ClearQuest. См. “Инсталляция ClearQuest Windows для конечных пользователей” на странице 27 и “Инсталляция ClearQuest Unix для конечных пользователей” на странице 29.

6. Если Вы инсталлируете ClearQuest Web, см. главу “Установка ClearQuest Web” на странице 32.
2. Конфигурирование баз данных поставщика

Прежде, чем Вы начнете инсталлировать Rational ClearQuest, Вы должны установить и сконфигурировать базы данных поставщика, которые Вы будете использовать с ClearQuest.
ClearQuest требует по крайней мере двух баз данных:
· Репозиторий схем: это главная база данных, в которой ClearQuest сохраняет схемы.
Пользовательская база данных: это та база данных, где сохраняются данные, введенные пользователями ClearQuest (client и web). Вы можете иметь столько пользовательских баз данных, сколько Вам нужно.
Эта глава освещает следующие темы:
· “Выбор поставщика базы данных” на странице 8
“Установка Microsoft Access” на странице 8
· “Установка SQL Anywhere” на странице 9
·  “Установка Microsoft SQL Server Version 6.5” на странице 11
“Установка Microsoft SQL Server 7 и 2000” на странице 14
· “Установка Oracle Server” на странице 16
· “Установка IBM DB2 6.1” на странице 19
Выбор поставщика базы данных

ClearQuest поддерживает следующие базы данных:
· База данных минимальной конфигурации: Microsoft Access (поставляется с ClearQuest)
· База данных среднего уровня: Sybase SQL Anywhere (поставляется с ClearQuest)
· Базы данных высокого уровня: Microsoft SQL Server и Oracle (NT и Unix)
О специфике поддерживаемых версий, см. Примечания к выпуску ClearQuest:
· Для Windows: <d>:\ClearQuest\readme.htm (где <d> - ваш драйвер CD-ROM)
· Для Unix: <d>:/products/ClearQuestClient/readme.htm (где <d> - ваш драйвер CD-ROM)
Примечание: Если ваша инсталляция ClearQuest будет включать клиентов ClearQuest Unix, ваша база данных поставщика должна быть Oracle, и она должна быть установлена на сервере Unix.
Чтобы решить, какая база данных поставщика является лучшей для ваших потребностей, определите, сколько пользователей Вы ожидаете иметь одновременных. Используйте следующие общие рекомендации:
· Для начального тестирования и оценки или для маленьких групп (меньше, чем пять пользователей), Вы можете использовать базу данных минимальной конфигурации.
· Для маленьких групп и групп среднего размера (от пяти до двадцати пользователей), Вы можете использовать базу данных среднего уровня.
· Для больших групп (более двадцати пользователей), большого количества данных или для достижения лучшей эффективности, используют одну из систем баз данных высокого уровня.
Примечание: Для баз данных ClearQuest Вы можете использовать более одной системы баз данных. Например, Вы можете использовать базу данных высокого уровня для репозитория схем и пользовательских баз данных, и использовать начальную или базу данных среднего уровня для вашей тестовой базы данных.
Установка Microsoft Access
Примечание: ClearQuest Web не поддерживает базы данных Microsoft Access.
Если Вы используете ClearQuest с Microsoft Access,
1. Создайте один общедоступный каталог на машине для каталога, который будет содержать ваши базы данных Microsoft Access.

2. Возьмите на заметку путь UNC общего каталога. Путь должен иметь форму:

\\<machine_name>\<share_name>\<database_directory>\

Например:
\\developmentserver\project34share\clearquestdbs\

Когда Вы будете выполнять ClearQuest в первый раз, Вам будет предложено создать репозиторий схем. Вы определите это имя пути и представите имя файла для репозитория схем. После этого, ClearQuest создаст и инициализирует соответствующие базы данных Access в этом каталоге.

Теперь, когда Вы установили базы данных Access, перейдите к главе “Инсталляция ClearQuest для администратора” на странице 21.
Установка SQL Anywhere

Чтобы создать сервер базы данных SQL Anywhere, выполните следующее:
· Инсталлируйте программное обеспечение cервера Sybase SQL Anywhere. (Примечание: SQL Anywhere доступен на компакт-диске ClearQuest и может быть установлен с использованием мастера Rational Software Setu).
· Выберите или создайте учетную запись пользователя для запуска сервера базы данных SQL Anywhere и установки прав пользователей. См. Определение прав пользователя ниже.
· Создайте сервер базы данных SQL Anywhere. См. Создание сервера базы данных SQL Anywhere на странице 10.
Определение прав пользователя
Чтобы определить права для учетной записи пользователя, запускающего сервер базы данных SQL Anywhere:
1. Удостоверьтесь, что Вы установили программное обеспечение сервера Sybase SQL Anywhere.
2. Сделайте одно из следующего:

· Если на вашем компьютере установлено программное обеспечение Windows NT Workstation, нажмите Start > Programs > Administrative Tools (Common) > User Manager.
· Если на вашем компьютере установлено программное обеспечение Windows NT Server:

· Нажмите Start > Programs > Administrative Tools (Common) > User Manager for Domains.

· Нажмите User > Select Domain и напечатайте локальное имя машины в блоке Domain,  затем нажмите OK.
Примечание: Если пользователь еще не существует, создайте пользователя (User > New User).
3. Нажмите Policies > User Rights, чтобы открыть диалоговое окно User Rights Policy.
4. Выберите Show Advanced User Rights.
5. В списке Right диалогового окна User Rights Policy, выберите Access this computer from network.
6. Нажмите Add.
7. В List Names From выберите домен учетной записи запуска сервера базы данных SQL Anywhere.
8. Нажмите Show Users.
9. В списке Names выберите учетную запись запуска сервера базы данных SQL Anywhere.
10. Нажмите Add и затем нажмите OK.
11. В списке Right диалогового окна User Rights Policy выберите Log on as a service.
12. Повторите шаги от 6 до 10.
13. В списке Right диалогового окна User Rights Policy выберите Log on locally
14. Повторите шаги от 6 до 10.
15. Нажмите OK.
16. Нажмите User > Exit.
Создание сервера базы данных SQL Anywhere
Сервер базы данных SQL Anywhere – это процесс, который выполняется на машине сервера базы данных. Его функция - координировать все действия на ваших базах данных SQL Anywhere. Вы создаете один сервер SQL Anywhere, чтобы обеспечить доступ ко всем вашим файлам баз данных.
Выполните следующие шаги, чтобы использовать Rational Administrator для создания нового сервера:
1. В меню Start нажмите Sybase SQL Anywhere Database Server > Rational Administrator.
2. Нажмите File > New SQL Anywhere Database Server.

3. Напечатайте уникальную алфавитно-цифровую строку до 30 символов, которая идентифицирует этот сервер базы данных в сети, и затем нажмите Next.
Важно: Не используйте пробелы или специальные символы в имени сервера (символы подчеркивания приемлемы).
4. Напечатайте количество пространства, используемого при кэшировании данных для сервера базы данных SQL Anywhere, а затем нажмите Next. Допустимо – 2048 KB для каждого репозитория Rational на сервере.
5. Выберите один или более протоколов для связывания с сервером базы данных SQL Anywhere, и затем нажмите Next.
Примечание: Чтобы сократить время соединения, выберите только те протоколы, которые фактически используются на вашей сети.
6. Выберите параметры Startup, как описано в следующих шагах.
a. Выберите один из следующих параметров Windows NT Service Startup. Эти параметры запускают сервер базы данных SQL Anywhere, когда Вы включаете вашу систему:
· Нажмите Automatic, чтобы автоматически запускать сервер базы данных SQL Anywhere, когда Вы запускаете вашу систему.
· Нажмите Manual, если Вы не хотите, чтобы  сервер базы данных SQL Anywhere запускался автоматически, когда Вы запускаете вашу систему. Если Вы выбираете эту опцию, Вы должны будете вручную запускать сервер базы данных, каждый раз, когда Вы перезагружаете машину сервера.
b. Выберите или отмените Start service immediately. Эта опция стартует сервер базы данных SQL Anywhere немедленно после того, как Вы его создадите. При отмене Вы должны будете запустить сервер вручную после его создания.

7. В разделе Account проделайте следующее.
a. Нажмите Other Account, чтобы позволить пользователям обращаться к общедоступной базе данных ClearQuest или общедоступному репозиторию. Эта опция дает пользователям больше гибкости для доступа к базе данных или репозиторию.
Примечание: Не используйте опцию System Account (LocalSystem). Она не позволяет Вам выполнять дистанционное конфигурирование базы данных ClearQuest с  использованием UNC.
b. Напечатайте домен и имя учетной записи пользователя для Other Account. Это та учетная запись, которую Вы создали и сконфигурировали в разделе Определение прав пользователя на странице 9. Имя чувствительно к регистру.
Введите информацию учетной записи пользователя следующим образом:
· Если Вы создали учетную запись на локальной машине (см. шаге 2 на странице 9), введите домен и имя учетной записи как:
.\userid
· Если Вы создали учетную запись в домене, введите домен и имя учетной записи как:

domain\userid

c. Напечатайте пароль для Other Account. Пароль чувствителен к регистру.
8. Нажмите Next.
Rational Administrator отображает итоговую подборку ваших выборов.
9. Нажмите Finish.
10. После установки программного обеспечения SQL Anywhere, создайте один общий каталог на машине для каталогов, которые содержат ваши базы данных SQL Anywhere. (Чтобы увеличить эффективность, сохраняйте ваши базы данных на той же машине, что и сервер базы данных.)
11. Запишите путь UNC общего каталога. Путь должен иметь форму:
\\<machine_name>\<share_name>\<database_directory>
Например:
\\developmentserver\project34share\clearquestdbs

Now that you have set up your SQL Anywhere databases, proceed to “Installing ClearQuest for an administrator” on page 37.
Теперь, когда Вы установили ваши базы данных SQL Anywhere, перейдите к главе Инсталляция ClearQuest для администратора на странице 3. Инсталляция ClearQuest для администратора.
Установка Microsoft SQL Server Version 6.5

Инсталлируйте SQL Server 6.5 с SQL Server Service Pack 5a, если Вы его еще не установили.
Примечание: Когда Вы инсталлируете SQL Server, выберите один из следующих параметров порядка сортировки:
Dictionary order, case-sensitive (лексикография с учетом регистра)
· Dictionary order, case-insensitive (лексикография без учета регистра)
Если Вы изменяете порядок сортировки после установки SQL Server, Вы должны переустановить базы данных SQL и перезагрузить данные.
Примечание: Этот выбор затронет чувствительность к запросам ClearQuest. Если Вы хотите, чтобы запросы ClearQuest не учитывали регистра, установите такой порядок.
Регистрация вашей машины сервера SQL в SQL Server 6.5
Запустите SQL Server Enterprise Manager. Если машина сервера SQL еще не зарегистрирована, зарегистрируйте ее теперь.
1. Нажмите Server > Register Server.
2. Напечатайте имя сервера.
Примечание: Запишите имя сервера, потому что оно понадобится Вам при инсталляции ClearQuest.
3. Нажмите Use Standard Security.
4. В поле Login ID напечатайте SA (имя системноно администратора).
5. В поле Password напечатайте ваш пароль системного администратора.
6. Нажмите Register.
Сервер должен появиться в списке серверов.
7. Установите базы данных SQL Server как описано в следующем разделе.
Установка баз данных SQL Server 6.5
Вы должны установить одну пустую базу данных SQL Server 6.5 для репозитория схем ClearQuest, и по одной пустой базе данных SQL Server 6.5 для каждой пользовательской базы данных ClearQuest (типа необязательной базы данных SAMPL). Для каждой  базы данных SQL Server 6.5 выполните следующие задачи:
· Создайте пустую базу данных
· Создайте учетную запись регистрации для базы данных
· Установите для базы данных порядок резервного копирования
Чтобы добавить к ClearQuest большее количество баз данных, выполните предшествующие задачи для каждой новой базы данных.
Примечание: Эти инструкции предполагают, что Вы имеете простую конфигурацию SQL Server. Если Вы имеете большие базы данных или много пользователей, рассмотрите установку файла регистрации на отдельных устройствах или распределение данных на множестве устройств. За подробностями обратитесь к документации SQL Server.
Создание пустых баз данных
Используйте SQL Server Enterprise Manager, чтобы создать пустые базы данных SQL Server 6.5 для репозитория схем ClearQuest и для каждой пользовательской базы данных ClearQuest (типа базы данных SAMPL).
Примечание: Ваши базы данных SQL Server должны быть в том же сетевом домене, что и ваш сервер ClearQuest Web и все клиенты ClearQuest или инструментальные средства, которые должны соединяться с базой данных. Если он не в том же самом домене, то Вы получите ошибку. См. Примечания к выпуску ClearQuest для большего количества подробностей. Консультируйтесь в Microsoft KnowledgeBase Article Q152828, http://premium.microsoft.com/support/kb/articles/q152/8/28.asp.

Для каждой базы данных SQL Server 6.5 проделайте следующее.
1. Создайте устройство данных.
a. Выберите вашу машину сервера SQL. Если ваша машина не появляется в списке серверов, Вы должны зарегистрировать ее. См. Регистрация вашей машины сервера SQL в SQL Server 6.5 на странице 11.
b. Нажмите Manage > Database Devices.
c. Нажмите иконку New Device.
d. Напечатайте название для устройства, выберите расположение и напечатайте размер.
Для репозитория схем оппределите, по крайней мере, 50 MB. Устройство должно быть достаточно большим, чтобы содержать все версии схемы. Вы можете корректировать этот размер позже, в случае необходимости.
Для пользовательской базы данных определите, по крайней мере, 15 MB для каждых 1,000 записей, которые Вы рассчитываете генерировать. Точное количество требуемого пространства зависит от сложности вашей схемы.
e. Нажмите Create Now.
Новое устройство теперь должно появиться в списке устройств.
f. Закройте окно Manage Database Devices.
2. Создайте базу данных.
a. Нажмите Manage > Databases.
b. Нажмите иконку New Database.
c. Напечатайте имя для базы данных.
d. В поле Data Device выберите устройство, которое Вы только что создали.
e. Оставьте Log Devices как none.
f. Нажмите Create Now.
Новая база данных теперь должна появиться в списке баз данных.
3. Сконфигурируйте базу данных:
a. В окне Manage Database дважды щелкните базу данных, которую Вы только создали Появляется. диалоговое окно Edit Database.
b. Нажмите закладку Options.
c. Нажмите Select Into/Bulk Copy и Truncate Log on Checkpoint.
d. Нажмите OK.
e. Закройте окно Manage Databases.
Создание учетной записи регистрации для каждой базы данных
Используйте SQL Server 6.5 Enterprise Manager, чтобы создать учетную запись регистрации для ClearQuest. ClearQuest использует эту учетную запись для регистрации в программе базы данных сервера SQL от имени пользователей ClearQuest. Эта учетная запись отдельная от учетных записей пользователей ClearQuest и она скрывается после инсталляции.
Примечание: Когда Вы создаете репозиторий схем ClearQuest, инструмент ClearQuest Maintenance запрашивает Вас относительно трех учетных записей регистрации, перечисленных ниже. Если Вы не хотите создавать три отдельных учетных записи, Вы можете использовать идентификатор входа в систему DBO для всех трех.
Создайте следующие учетные записи регистрации входа в систему для каждой базы данных, используя авторизацию сервера SQL:
· Учетная запись владельца базы данных (DBO)
· Учетная запись общего назначения
· Другая учетная запись общего назначения для использования репозиторием схем. Эта третья учетная запись будет использоваться только для чтения ClearQuest.
Примечание: Вы должны будете установить сервер SQL для работы в смешанном режиме (Windows NT Authentication и SQL Server Authentication). Опция Mixed Mode может быть установлена через Enterprise Manager; щелкните правой кнопкой мыши на сервере и выберите меню Properties, закладку Security Mixed Mode.
Выполните следующие шаги, чтобы создать учетную запись регистрации:
1. Нажмите Manage > Logins.
2. Напечатайте уникальное имя для входа в систему и пароль.
Примечание: Запомните имена и пароли каждой учетной записи; они потребуются вам при инсталляции ClearQuest.
3. В столбце Permit нажмите базу данных, для которой Вы создаете учетную запись. В столбце Permit должна появиться галочка.
4. Если Вы создаете учетную запись владельца базы данных, нажмите столбец Alias и выберите DBO.
5. Нажмите Add и подтвердите пароль.
6. Повторите шаги со 2 по 5 для других учетных записей.
7. Закройте окно Manage Logins.
Установка процедуры резервного копирования базы данных

Описанный здесь порядок резервного копирования обеспечивает ежедневное копирование баз данных ClearQuest путем записи поверх резервного устройства. Это предполагает, что ваш вычислительный центр также периодически выполняет резервное копирование  резервных устройств средствами восстановления.
Используйте SQL Server Enterprise Manager, чтобы установить расписания резервного копирования репозитория схем и баз данных.
1. Нажмите Tools > Database Backup/Restore.
2. В диалоговом окне Database Backup/Restore нажмите вкладку Backup.
3. Из списка Database Backup выберите базу данных, которую Вы хотите поддерживать.
4. Из списка Backup Devices выберите New.
5. Напечатайте имя и выберите расположение. Мы рекомендуем, чтобы Вы поместили резервное устройство на другой диск, чем устройства баз данных.
6. Выберите Disk Backup Device.
7. Выберите Create.
8. Нажмите Schedule.

9. В диалоговом окне Backup Volume Labels, оставьте незаполненным Volume level.
10. В диалоговом окне Schedule Backup выберите Recurring.
11. Нажмите Change.

12. В поле Daily Frequency выберите 12 a.m. или другое время по вашему выбору.

13. Нажмите OK, чтобы закрыть открытые диалоговые окна.

14. Нажмите Close, чтобы закрыть диалоговое окно Database Backup/Restore.
Now that you have set up your SQL Server databases, proceed to “Installing ClearQuest for an administrator” on page 37.
Теперь, когда Вы установили ваши базы данных SQL Server, перейдите к главе Инсталляция ClearQuest для администратора на странице 25.
Установка Microsoft SQL Server 7 и 2000

You need to set up one empty SQL Server database for the ClearQuest schema repository, and one empty SQL Server database for each ClearQuest Client user database (such as the optional SAMPL database). For each SQL Server database, complete the following tasks.

Вы должны установить одну пустую базу данных SQL Server для репозитория схем ClearQuest, и одну пустую базу данных СЕРВЕРА SQL для каждой пользовательской базы данных ClearQuest Client (типа необязательной базы данных SAMPL). Для каждой базы данных SQL Server, выполните следующие задачи.
·  (Verify) server registration
(Проверьте) регистрацию сервера
·  Create an empty database

Создайте пустую базу данных
·  Set up a backup procedure for the database

Установите порядок действий для базы данных при отказе 
·  Create a SQL Server login with the db_owner role to use for the ClearQuest database logins (the same login is used by ClearQuest for all connections).

Создайте вход в систему SQL Server с ролью db_owner, чтобы использовать для входов в систему базы данных ClearQuest (тот же самый вход в систему используется для всех связей ClearQuest).
Note: Do not use the SA (system administrator) login. During an upgrade or move process, ClearQuest requires empty databases. However, if the SA login is used, ClearQuest is able to see the System Tables, assumes the database is not empty, and does not allow the upgrade/move process to continue.

Примечание: Не используйте вход в систему SA (системный администратор). В течение процесса обновления или перемещения, ClearQuest требует пустых баз данных. Однако если используется вход в систему SA, ClearQuest имея возможность видеть System Tables, предполагает, что  база данных не пуста, и не позволяет продолжаться процессу обновления / перемещения.
For SQL Server 2000 users:When installing SQL Server 2000, it is important to select the default registration name for your database server. This will make the registration name the same as your server’s machine name.

Для пользователей SQL Server 2000: Когда устанавливается SQL Server 2000, важно выбрать заданное по умолчанию регистрационное имя для вашего сервера базы данных. Его желательно сделать таким же, как имя машинны вашего сервера.
If you want to add more user databases to ClearQuest, repeat the preceding tasks for each new database.

Если Вы хотите добавить больше пользовательских баз данных к ClearQuest, повторите предыдущие задачи для каждой новой базы данных.
Registering your SQL Server machine for SQL Server

Регистрация вашей машины SQL Server к SQL Server
1.  In the SQL Server Enterprise Manager, select your Windows NT server in the SQL Server Group.

В SQL Server Enterprise Manager выберите ваш Сервер Windows NT в SQL Server Group.
If your server is not shown, register it now by going to Step 2. If your server is already registered, go to “Creating a new SQL Server 7 database” on page 25.

Если ваш сервер не показывается, зарегистрируйте его сейчас,  перейдите к шагу 2. Если ваш сервер уже буферизован, идите к “Создание нового SQL Server 7 базы данных” на странице 25.
2. Right-click on the SQL Server Group and select New SQL Server Registration. The Register SQL Server Wizard displays.

Щелкните правой кнопкой мыши на SQL Server Group и выберите New SQL Server Registration. Отображается Register SQL Server Wizard.
3. Select a server name, and click Next.
Выберите имя сервера и нажмите Next.
Note: Make a note of the server name because you will need it during the ClearQuest installation.

Примечание: Запишите имя сервера, потому что оно будет необходимо Вам в  течение инсталляции ClearQuest.
4. For Authentication Mode, select SQL Server, then click Next.

Для Authentication Mode выберите SQL Server, затем нажмите Next.
5. For Login ID, type SA, and for Password, type your SA password. Then click Next. (The SA user has the privilege to create logins and databases.)

Для Login ID напечатайте SA, и для Password напечатайте ваш пароль SA. Затем нажмите Next. (Пользователь SA имеет привилегию создавать входы в систему и базы данных.)
6. Add this server to an existing group, or create a new group. Then click Next.

Добавьте этот сервер к существующей группе, или создайте новую группу. Затем нажмите Next.
7. Click Finish. The server will appear in the list of servers.

Нажмите Finish. Сервер будет появляться в списке серверов.
Creating a new SQL Server 7 database

Создание новой базы данных SQL Server 7
1.  From the Getting Started Taskpad, select Administer SQL Server > Create a database.

Из Getting Started Taskpad выберите Administer SQL Server > Create a database.
2. In the wizard, specify a file system location for the database and the log. You can accept the defaults for the growth rate of the database and the log.

В мастере определите расположение файловой системы для базы данных и файла регистрации. Вы можете принимать значения по умолчанию для скорости роста базы данных и файла регистрации.
If you want to give the databases larger initial values, allocate at least 50 MB for the schema repository and at least 15 MB for every 1,000 records expected for your user databases.

Если Вы хотите дать базам данных большие первоначальные значения, распределите, по крайней мере, 50 MB для репозитория схем и, по крайней мере, 15 MB для каждых 1,000 ожидаемых записей для ваших пользовательских баз данных.
3. After you create a database, you are prompted to create a Database Maintenance Plan. The Database Maintenance Plan Wizard allows you to set up a database backup routine. It is strongly recommended that you set up automated nightly backups for all your ClearQuest databases.

После того, как Вы создали базу данных, Вы получаете запрос о создании Database Maintenance Plan. Database Maintenance Plan Wizard позволяет Вам установить стандартную резервную базу данных. Строго рекомендуется, чтобы Вы всегда устанавливали автоматизированные резервы для всех ваших баз данных ClearQuest.
4. Set database properties for the new database:

Установите свойства базы данных для новой базы данных:
a. Select the new database from the server’s databases folder.

Выберите новую базу данных из папки databases сервера.
b. Right-click on the database and select Properties.

Щелкните правой кнопкой мыши на базе данных и выберите Properties.
c. On the Options tab, select these Settings:

На вкладке Options выберите эти Settings:
· Select into / bulk copy

Выберите into / bulk copy
·  Truncate log on checkpoint
Усеките войдут контрольная точка??????
d.  Click OK.
Нажмите OK.
Creating SQL Server logins

Создание входов в систему SQL Server
 Create a db_owner login for each ClearQuest database (schema repository and each user database) by selecting the db_owner role for each of the logins you create.

Создайте вход db_owner в систему для каждой базы данных ClearQuest (репозитория схем и каждой пользовательской базы данных) выбирая роль db_owner для каждого из входов в систему, которые Вы создаете.
Note: Do not use the SA (system administrator) as the owner login of a ClearQuest database. During an upgrade or move process, ClearQuest requires empty databases. However, if the SA login is used, ClearQuest is able to see the System Tables, assumes the database is not empty, and does not allow the upgrade/move process to continue.

Примечание: Не используйте SA (системный администратор) как вход в систему владельца базы данных ClearQuest. В течение обновления или процесса перемещения ClearQuest требует пустых баз данных. Однако если используется вход SA в систему, ClearQuest, видя System Tables, предполагает, что  база данных не пуста, и не позволяет продолжаться процессу обновления / перемещения.
1. Expand the Security folder, then right-click Logins, and click New Login. The SQL Server Login Properties - New Login dialog box displays.

Разверните папку Security, затем щелкните правой кнопкой мыши Logins, и нажмите New Login. Отображается диалоговое окно SQL Server Login Properties - New Login.
2. On the General tab, select SQL Server authentication mode because ClearQuest does not support Windows authentication.

На вкладке General выберите SQL Server authentication mode, потому что ClearQuest не поддерживает идентификацию Windows.
Note: Because ClearQuest requires a SQL Server login for each database and does not support Windows NT Authentication, you will need to set up SQL Server to operate in Mixed Mode (Windows NT Authentication and SQL Server Authentication). This property can be set via Enterprise Manager, right-click on the server and select Properties menu, Security tab.

Примечание: Поскольку ClearQuest требует входа в систему SQL Server для каждой базы данных и не поддерживает Windows NT Authentication, Вы должны будете установить SQL Server, чтобы оперировать в смешанном режиме (Windows NT Authentication и SQL Server Authentication). Это свойство может быть установлено через Enterprise Manager щелчком правой кнопкой мыши на сервере и выбором меню Properties и вкладки Security.
3. Enter a name and password.

Введите имя и пароль.
4. In the Defaults area, select your database and leave the Language set to <default>.

В области Defaults выберите вашу базу данных и оставьте установку Language к значению < default >.
5. On the Server Roles tab, do not grant any server roles.

На вкладке Server Roles не устанавливайте никакие роли сервера.
6. Click OK and verify your password.

Нажмите OK и проверьте ваш пароль.
7. Grant db_owner privileges to the login in the new database.

Предоставьте привилегии db_owner для входа в систему в новой базе данных.
a. On the Database Access tab, select from the Permit list the new database to grant the login permission.

На вкладке Database Access выберите от списка Permit новую базу данных, чтобы предоставить разрешение входа в систему.
b. Under Permit in database role, check db_owner and public. Do not grant this user any other privileges.
Под Permit in database role включите db_owner и общедоступность. Не предоставляйте этому пользователю никаких других привилегий.
Migrating from SQL Server 6.5

Перемещение из SQL Server 6.5
Use the ClearQuest Maintenance Tool to migrate your schema repository to a SQL Server 7 database. Then use ClearQuest Designer to move previous SQL Server 6.5 user databases to SQL Server 7. You do this by using the Properties dialog box to change the properties of the user database.

Используйте ClearQuest Maintenance Tool, чтобы переместить ваш репозиторий схем к базе данных SQL Server 7. Затем используйте ClearQuest Designer, чтобы переместить предыдущие пользовательские базы данных SQL Server 6.5 в SQL Server 7. Вы делаете это,  используя диалоговое окно Properties, чтобы изменить свойства пользовательской базы данных.
Warning: When migrating from SQL Server 6.5 to SQL Server 7, do not use the SQL Server 7 Upgrade Wizard to upgrade your schema repository and user databases. You need to use the ClearQuest Maintenance Tool and ClearQuest Designer.

Предупреждение: При перемещении из SQL Server 6.5 к SQL Server 7 не используйте SQL Server 7 Upgrade Wizard, чтобы модернизировать ваш репозиторий схем и пользовательские базы данных. Вы должны использовать ClearQuest Maintenance Tool и ClearQuest Designer.
Ensuring SQL Server 7 Client Connectivity
Обеспечение связанности SQL Server 7 Client
 SQL Server 7 client machines require SQL Server ODBC driver number 3.7x. To update the ODBC driver for a client machine:

Машины SQL Server 7 client требуют ODBC драйвер 3.7x SQL Server. Чтобы модифицировать драйвер ODBC для машины клиента:
1. Go to that machine, insert the SQL Server 7 CD-ROM, and run

Перейдите на эту машину, вставьте SQL Server 7 CD-ROM и запустите
 D:\x86\other\mdac_type.exe

where D: is the letter of your CD-ROM drive.

Где D: - символ вашего драйвера CD-ROM.
2. Choose the Custom install option when prompted.

При запросе выберите опцию установки Custom.
3. Select ODBC Driver for Microsoft SQL Server (and unselect other options such as Microsoft JetEngine).

Выберите ODBC Driver for Microsoft SQL Server (и не выбирайте другие параметры типа Microsoft JetEngine).
Now that you have set up your SQL Server databases, proceed to “Installing ClearQuest for an administrator” on page 37
Теперь, когда Вы установили ваши базы данных SQL Server, перейдите к “Установка ClearQuest для администратора” на странице 37
Установка Oracle Server

Если Вы используете ClearQuest с базами данных Oracle, инсталлируйте и создайте базы данных согласно документации Oracle. Следуйте этим рекомендациям, когда устанавливаете ваши базы данных Oracle:
· Создайте специальный экземпляр базы данных Oracle или идентифицируйте существующий экземпляр Oracle, чтобы использовать его для данных ClearQuest.
· Создайте двух или более отдельных пользователя базы данных Oracle (каждого со своим входом в систему):
· для входа в систему пользователя репозитория схем ClearQuest
· по одному для входа в систему пользователя каждой пользовательской базы данных ClearQuest
· Предоставьте каждому пользователю только роли Connect и Resource.
· We recommend that you associate each Oracle database user with a unique default table space that is separate from all other users.

Мы рекомендуем, чтобы Вы связали каждого пользователя базы данных Oracle с уникальным значением по умолчанию tablespace, которое изолировано от всех других пользователей.
Note: The Oracle database users can share the temporary tablespace(s), but the temporary tablespace(s) for these users must be separate from the Oracle system tablespace.

Примечание: пользователи базы данных Oracle могут совместно использовать tablespace (s) temporary, но временный tablespace (s) для этих пользователей должен быть изолирован от tablespace системы Oracle.
Note: If your ClearQuest installation will include ClearQuest Unix clients, your vendor database must be Oracle and it must be installed on a Unix server.
Примечание: Если ваша инсталляция ClearQuest будет включать клиентуру ClearQuest Unix, ваша база данных поставщика должна быть Oracle, и она должна быть установлена на сервере Unix.
Configuring an Oracle client installation for ClearQuest Windows

Конфигурирование инсталляции Oracle client для ClearQuest Windows
 The ClearQuest administrator and all ClearQuest Windows end-users must install Oracle Client Software on their local machines before they can install and use ClearQuest. To install Oracle Client Software, follow the Oracle Networking Products documentation.

Администратор ClearQuest и все конечные пользователи ClearQuest Windows должны установить программное обеспечение Oracle Client на своих локальных машинах прежде, чем они смогут устанавливать и использовать ClearQuest. Чтобы установить программное обеспечение Oracle Client, следуйте за документацией Oracle Networking Products Oracle Networking Products.
Before using ClearQuest Windows, all users must use the SQL*Net Easy Configuration or SQL8*Net Easy Configuration program to configure their computers to access Oracle databases.

Перед использованием ClearQuest Windows все пользователи должны воспользоваться SQL*Net Easy Configuration или программой SQL8*Net Easy Configuration, чтобы конфигурировать свои компьютеры для доступа к базам данных Oracle.
IMPORTANT: Even if you will only be using ClearQuest Unix clients , you need to use the SQL*Net Easy Configuration tool to configure the administrator’s NT workstation to access the Oracle database. ClearQuest Unix requires that the administrator machine be a Windows machine.

ВАЖНО: Даже если Вы будете использовать только клиентуру ClearQuest Unix, Вы должны использовать инструмент SQL*Net Easy Configuration, чтобы конфигурировать рабочее место NT администратора, чтобы обратиться к базе данных Oracle. ClearQuest Unix требует, чтобы машина администратора была машиной Windows.
1. From the Start menu, click Oracle for Windows NT > SQL*Net Easy Configuration if using Oracle 7.x or click Oracle for Windows NT > SQL8*Net Easy Configuration if using Oracle 8.x and complete these steps:

В меню Start нажмите Oracle for Windows NT > SQL*Net Easy Configuration при использовании Oracle 7.x или нажмите Oracle for Windows NT > SQL8*Net Easy Configuration при использовании Oracle 8.x и выполните эти шаги:
2. Select View Configuration Information to see if your Oracle database administrator configured a Database Alias for you. If not, go to the next step.

Выберите View Configuration Information, чтобы видеть, конфигурировал ли ваш администратор базы данных Oracle для Вас Database Alias. Если нет, перейдите к следующему шагу.
3. Add a new database alias by selecting Add Database Alias. Click OK.

Добавьте новое условное название базы данных,  выбирая Add Database Alias. Нажмите OK.
4. Type a SQL*Net Database Alias (database name your Oracle database administrator set up previously). Make a note of the Database Alias because you will need it during the ClearQuest database setup. Click OK.

Напечатайте SQL*Net Database Alias (база данных называет вашего администратора базы данных Oracle, установленного предварительно). Запишите Database Alias, потому что оно будет необходимо Вам в течение установки базы данных ClearQuest. Нажмите OK.
Note: All ClearQuest users must use the same Database Alias.

Примечание: Все пользователи ClearQuest должны использовать одинаковое Database Alias.
5. Select TCP/IP as the network protocol to use to communicate with the database. Click OK.

Выберите TCP/IP как сетевой протокол, чтобы использовать его для связывания с базой данных. Нажмите OK.
6. Type the Host Name (the name of database server machine) and the Database Instance (the system ID or SID). Get this information from your Oracle database administrator.

Напечатайте Host Name (имя машины сервера базы данных) и Database Instance (системный ID или SID). Получите эту информацию от вашего администратора базы данных Oracle.
Note: All ClearQuest users must use the same Database Alias, Database Instance (system ID or SID), TCP/IP protocol, and Host Name (Oracle server machine).
Примечание: Все пользователи ClearQuest должны использовать одинаковые Database Alias, Database Instance (системный ID или SID), протокол TCP/IP и Host Name (машина сервера Oracle).
7. When you click OK, the SQLNet Easy (or SQLNet8 Easy) Configuration program asks you to confirm your choices. Click Yes to confirm the current configuration information.

Когда Вы нажмете OK, программа SQLNet Easy (или SQLNet8 Easy) Configuration запросит, чтобы Вы подтвердили ваши выборы. Нажмите Yes, чтобы подтвердить текущую конфигурационную информацию.
8. After configuring your database, the installer displays the initial opening screen so that you can configure additional aliases. To quit the program, click Cancel.

После конфигурирования вашей базы данных, инсталлятор отображает начальный экран открытия так, чтобы Вы могли конфигурировать дополнительные условные названия. Чтобы выйти из программы, нажмите Cancel.
Enhancing search capabilities
Расширение поисковых возможностей
 With a standard Oracle installation, you cannot perform a string search on multi-line text fields. For example, in ClearQuest you cannot search for text in a multi-line Notes field.

Со стандартной инсталляцией Oracle Вы не можете выполнять поиск строк на многострочных текстовых полях. Например, в ClearQuest Вы не можете искать текст в многострочном поле Notes.
Oracle does provide an option called the ConText Option (Oracle 7), ConText Cartridge (Oracle 8) or IntermediaText (Oracle 8.1.x) that enables string searches in multi-line text fields. When installed, multi-line text fields become available for queries in ClearQuest.

Oracle обеспечивает опцию, называемую ConText Option (Oracle 7), ConText Cartridge (Oracle 8) или IntermediaText (Oracle 8.1.x), которая допускает поиск строк в многострочных текстовых полях. Когда эта опция установлена, многострочные текстовые поля становятся доступными для запросов в ClearQuest.
For Oracle 7.x and Oracle 8.0.x

Для Oracle 7.x и Oracle 8.0.x
 To enable Oracle multi-line text search with ClearQuest, do the following.

Чтобы допустить для Oracle многострочный текстовый поиск с ClearQuest, сделайте следующее.
1. Install the ConText Option/Context Cartridge according to the Oracle documentation.

Установите ConText Option/Context Cartridge согласно документации Oracle.
2. Start at least two ConText servers. Be sure to use the QDM (Query, DDL, DML) personality options.

Запустите, по крайней мере, два сервера ConText. Убедитесь, что использовали опции специализации QDM (Query, DDL, DML).
3. To set up the ClearQuest Oracle user to have the necessary privileges, run the following SQL script using Oracle’s SQLPlus utility as the Oracle system user.

Чтобы установить для пользователя ClearQuest Oracle необходимые привилегии, выполните следующий сценарий SQL, используя утилиту SQLPlus Oracle как пользователь системы Oracle.
The SQL script (setup_cq_ora_user.sql) can be found in the ClearQuest installation directory (\\Rational Software\ClearQuest\).

Сценарий SQL (setup_cq_ora_user.sql) может быть найден в директории инсталляции ClearQuest (\\Rational Software\ClearQuest\).
sqlplus ctxsys/<password>@<tnsname>

@setup_cq_ora_user.sql <cquser>
where <cquser> is the name of the Oracle login used for creating the ClearQuest database.

где <cquser> - имя входа в систему Oracle, используемого для создания базы данных ClearQuest.
For Oracle 8.1.x

Для Oracle 8.1.x
1.  Install InterMedia Text according to the Oracle documentation. Generally, this is installed by default when the Oracle server is installed.

Установите InterMedia Text согласно документации Oracle. Вообще, это установлено по умолчанию, когда установлен сервер Oracle.
2. Start at least two ConText servers.

Запустите, по крайней мере, два сервера ConText.
3. To set up the ClearQuest Oracle user to have the necessary privileges, run the following SQL script using Oracle’s SQLPlus utility as the Oracle system user.

Чтобы установить для пользователя ClearQuest Oracle необходимые привилегии, выполните следующий сценарий SQL, используя утилиту SQLPlus Oracle как пользователь системы Oracle
The SQL script (setup_cq_ora8i_ctx.sql) can be found in the ClearQuest installation directory (\\Rational Software\ClearQuest\).

Сценарий SQL (setup_cq_ora8i_ctx.sql) может быть найден в директории инсталляции ClearQuest (\\Rational Software\ClearQuest\).
sqlplus system/<password@tnsname>

@setup_cq_ora8i_ctx.sql <cquser>

where <cquser> is the name of the Oracle login used for creating the ClearQuest database.

где <cquser> - имя входа в систему Oracle, используемого для создания базы данных ClearQuest.
For ClearQuest Unix clients

If your ClearQuest installation will include ClearQuest Unix clients, your vendor database must be Oracle and it must be installed on a Unix server.

In addition, after setting up your Oracle database server, you must also install OpenLink Request Broker to facilitate Oracle connections. See “Setting up the Oracle OpenLink Request Broker” on page 31.

Setting up the Oracle OpenLink Request Broker

If you will be supporting ClearQuest Unix clients, you need to install and start the OpenLink Request Broker.

1. Log into the Oracle server as the same user ID you will use when installing ClearQuest.

2. Change to the openlink_server directory in the Rational root directory that was created when you installed the ClearQuest components.
cd [Rational_dir]/ClearQuestOracleSupport/openlink_server/[arch]

3. Run install.sh and follow the prompts for the OpenLink Configuration utility, accepting defaults when available.

4. In the second phase of the installation, select 1) Request Broker and enter the requested information.

5. Next, select 9) for Oracle 7 or 10) for Oracle 8 and enter the path name of the Oracle home directory and the SID to be used.

6. Next, select S) Startup Request Broker.

7. Quit the OpenLink Configuration Utility.

Installing the OpenLink ODBC catalog views for Oracle 7 or Oracle 8

This task is done while connected to the internal database. Run the Oracle svrmgrl with the corresponding sql script, and use odbccat7.sql for Oracle 7 or odbccat8.sql for Oracle 8. The script(s) are located in the newly created bin directory.

1. Log in as the Oracle database administrator.

2. Change to the directory containing the odbccat7.sql or odbccat8.sql script:

cd [Rational_dir]/ClearQuestOracleSupport/openlink_server/[arch]/bin

3. Enter the following:

$ svrmgr1 lmode=y

SVRMGR>CONNECT internal;

SVRMGR>@odbccat7.sql

-- or--

SVRMGR>@odbccat8.sql

SVRMGR>EXIT;

For more information, see the comments in the odbccat*.sql file.
Automatically restarting the OpenLink broker on reboot

The following instructions assume your Unix installation uses the typical directories for startup and shutdown scripts.

To automatically restart the OpenLink Request Broker after rebooting the server:

1. Log in as root (root privileges are typically required for this step).

2. After installing the cd-image, there will be an rc.OpenLinkBroker file in:

[Rational_dir]/ClearQuestOracleSupport/openlink_server/[arch]

where [arch] is either hp10_pa or sun5.

For Solaris,

1. Copy the rc.OpenLinkBroker script to the /etc/init.d directory.

cp rc.OpenLinkBroker /etc/init.d/openlinkbroker

2. Edit the /etc/init.d/openlinkbroker script to change the value of BIN_DIR to be:

[Rational_dir]/ClearQuestOracleSupport/openlink_server/sun_5/bin

3. Make the script executable:

chmod +x /etc/init.d/openlinkbroker

4. Make symbolic links for startup and shutdown as follows. Note that the example uses "98" for startup and "02" for shutdown. You may need to use different numbers so that the startup script is invoked after any Oracle and NFS start up scripts.

ln -s /etc/init.d/openlinkbroker /etc/rc2.d/S98openlinkbroker

ln -s /etc/init.d/openlinkbroker /etc/rc2.d/K02openlinkbroker
For HP-UX,

1. Copy the rc.OpenLinkBroker script to the /etc/init.d/ directory.

cp rc.OpenLinkBroker /sbin/init.d/openlinkbroker

2. Edit the /sbin/init.d/openlinkbroker script to change the value of BIN_DIR to be:

[Rational_dir]/ClearQuestOracleSupport/openlink_server/hp10_pa/bin

3. Make the script executable:

chmod +x /sbin/init.d/openlinkbroker

4. Make symbolic links for startup and shutdown as follows. Note that the example uses "98" for startup and "02" for shutdown. You may need to use different numbers so that the startup script is invoked after any Oracle and NFS start up scripts.

ln -s /sbin/init.d/openlinkbroker /sbin/rc2.d/S98openlinkbroker

ln -s /sbin/init.d/openlinkbroker /sbin/rc2.d/K02openlinkbroker

Now that you have set up your Oracle databases, proceed to “Installing ClearQuest for an administrator” on page 37.
Установка IBM DB2 6.1

To use ClearQuest with IBM DB2 databases, you need to install IBM DB2 6.1 on the machine which you will use as your database server.

IMPORTANT: Please see the ClearQuest release notes before proceeding for more information about using DB2 databases with ClearQuest (\\ClearQuest\books\clearquest_readme.htm.).

Creating a new DB2 database

You need to set up one empty DB2 database for the ClearQuest schema repository, and one empty DB2 database for each ClearQuest user database (such as the optional SAMPL database). For each DB2 database, complete the following tasks.

1. From the Start menu, click DB2 for Windows NT > Control Center.

2. Enter the login name and password for the DB2 administrator account and click OK.

1. From the DB2 Control Center, expand the machine name that corresponds to the database server on which you will create the database until you see the Databases folder.

2. Right-click the Databases folder and choose Create > Database using Smart Guide.

Note: Make sure all DB2 services are running, otherwise this utility will not work.

3. Enter a name of the database. Note the DB2 supports database names will eight characters or less.

4. Click Done.

Creating a DB2 alias on client machine

All ClearQuest Windows client users (including the ClearQuest administrator) must install DB2 client software on their local machines before they can install and use ClearQuest. To install DB2 client software, follow the IBM documentation..36 Installing Rational ClearQuest

Note: If the client and server machines are the same, you can skip this step.

Before using ClearQuest Windows client, all users must use the Client Configuration Assistant to create a DB2 alias for each ClearQuest schema repository and user database they will use.

1. Install DB2 Client Software according to the IBM DB2 documentation.

2. From the Start menu, choose DB2 for Windows NT > Client Configuration Assistant. The Welcome dialog box appears.

3. Click Add database.

4. Click Search the network.

5. Click Next.

6. Expand the Known Systems folder, if you see the database server machine on which the ClearQuest database resides, expand it and select the database name for which you want to create an alias.

Note: If you don’t see the machine you need, try expanding the Other Systems folder. If you don’t see the machine you need in the Other Systems folder, talk to your database administrator. There may be a network problem.

7. Expand the database server machine folder you need and click the database for which you need to create an alias.

8. Click Next.

9. Click Done.

Now that you have set up your DB2 databases, proceed to “Installing ClearQuest for an administrator” on page 37.
3. Инсталляция ClearQuest для администратора

Перед установкой ClearQuest на клиентских машинах Вы должны инсталлировать его на машине администратора, установить лицензию и установить ваш репозиторий схем и пользовательские базы данных.

Если Вы используете базу данных Oracle или DB2, установите клиентское программное обеспечение Oracle или DB2 перед установкой ClearQuest. См. “Установка Oracle Server” на странице 16 или “Установка IBM DB2 6.1” на странице 19 для получения дополнительной информации.
Эта глава освещает следующие темы:

· “Инсталляция ClearQuest для администратора” на странице 21
“Создание баз данных ClearQuest” на странице 21
· “Установка интеграции с конфигурационным управлением” на странице 23
· “Установка представления записей через электронную почту” на странице 26
· “Инсталляция Crystal Reports” на странице 26
Инсталляция ClearQuest для администратора

Чтобы инсталлировать ClearQuest для администраторов:

1. Вставьте ClearQuest CD-ROM.

2. Если программа установки не запустилась автоматически, переместитесь к каталогу верхнего уровня CD-ROM и дважды щелкните setup.exe.

Мастер установки программного обеспечения Rational предлагает выбрать продукт для инсталляции; выберите ClearQuest.

3. Если Вы оцениваете ClearQuest, выберите инсталляцию Evaluator. Иначе, выберите инсталляцию Administrator.

4. Запустите License Key Administrator, чтобы ввести ваши лицензии ClearQuest. Следуйте инструкциям в вашем сертификате лицензии и в интерактивной справке программы License Key Administrator.

Примечание: Rational ClearQuest использует сервер лицензий FlexLM. Если у Вас не установлено изделие FlexLM license server, оно доступно на CD "Rational Solutions for Windows". Для получения дополнительной информации, см. руководство  Администрирование лицензий для Rational Software, доступное на CD "Rational Solutions for Windows Online Documentation".
Создание баз данных ClearQuest

После того, как Вы установили ClearQuest и сконфигурировали необходимые пустые базы данных поставщика (см. “Конфигурирование баз данных поставщика” на странице 8), Вы должны создать базы данных ClearQuest (репозиторий схем и пользовательские базы данных). Первоначально Вы можете создать пробную пользовательскую базу данных, чтобы использовать ее во время ознакомления с изделием. Позже Вы сможете создать ваши промышленные пользовательские базы данных.
Если Вы выбрали инсталляцию Evaluator, базы данных Microsoft Access создаются для Вас автоматически. Если Вы выбрали инсталляцию Administrator, выполните следующие шаги, чтобы создать базы данных ClearQuest:
Создание репозитория схем
1. Запустите ClearQuest Maintenance Tool (Start > Programs > Rational ClearQuest > ClearQuest Maintenance Tool).

Примечание: при первом запуске ClearQuest, Maintenance Tool запускается автоматически.

2. Выберите Create a new schema repository и нажмите Next.

3. Выберите базу данных поставщика, которую Вы планируете использовать, введите свойства, соответствующие этой базе данных, затем нажмите Next. Сохраните эту информацию для клиентов, чтобы использовать ее при соединении с базами данных. Вы должны ввести следующие свойства:

· MS_ACCESS
· Введите название для репозитория схем. Введите полный путь к файлу, используя стиль UNC. Например:

\\DevServer\ProjectShare\CQ_DBS\schema_repo.mdb

Вы можете найти каталог, в котором Вы хотите создать базу данных. Убедитесь, что при просмотре использовали Network Neighborhood, чтобы сохранить имя пути в стиле UNC.
· SQL_ANYWHERE
· Введите название для репозитория схем. Введите полный путь к файлу, используя стиль UNC. Например:

\\DevServer\ProjectShare\CQ_DBS\schema_repo.db

Вы можете найти каталог, в котором Вы хотите создать базу данных. Убедитесь, что при просмотре использовали Network Neighborhood, чтобы сохранить имя пути в стиле UNC.

· Enter the name of the database server.

Введите имя сервера базы данных.
· Enter the protocols used to communicate with the SQL Anywhere server.

Введите протоколы, используемые для связывания с сервером SQL Anywhere.
· Enter the database host name. The database host machine must be visible to the client machines via network share and via one or more of the communication protocols. For TCP/IP, this can also be the IP address.

Введите имя главной базы данных. Машина главной базы данных должна быть видима на машинах пользователя через проводник и через один или более протоколов связи. Для TCP/IP, это может также быть адрес IP.
· SQL_SERVER

· Enter an SQL Server database name for the database that will contain the schema repository.

Введите название базы данных SQL Server для базы данных, которая будет содержать репозиторий схем.
· Enter the name of the database server.

Введите  имя сервера базы данных.
· Enter the database owner (DBO or Administrator) login.

Введите владельца входа в систему базы данных (DBO или Administrator).
· Enter the password for the database owner (DBO or Administrator) login.

Введите пароль для владельца входа в систему базы данных (DBO или Administrator).
· Enter the general purpose or read/write login.

Введите универсальный или для чтения / записи вход в систему.
· Enter the password for the general purpose or read/write user login.

Введите пароль для универсального или для чтения / записи входа в систему пользователя.
· Enter the schema repository or read-only user login.

Введите репозиторий схем или вход в систему пользователя только для чтения.
· Enter the password for the schema repository or read-only login.
Введите пароль для репозитория схем или входа в систему только для чтения.
· ORACLE

· Enter the TNS name (SQL*Net Alias pointing to the Oracle instance).

Введите имя TNS (SQL*Net Alias, указывающий на экземпляр Oracle).
· Enter the Oracle login you created for the schema respository.

Введите вход в систему Oracle, который Вы создавали для репозитория схем.
· Enter the password for the login.

Введите пароль для входа в систему.
· The following options need to be entered in the Connect Options field, delimited by semi-colons. For example,

Следующие параметры должны быть введены в поле Connect Options, разграниченными точками с запятой. Например,
Host=<name>;SID=<name>;Server_ver=8.0;Client_ver=7;Lob_type=LONG

	Опция 
	Опрделение

	Host
	The name of the database server machine. If your ClearQuest deployment will include both Unix and Windows clients the Host name is mandatory.

Название машины сервера базы данных. Если ваше развертывание ClearQuest будет включать клиентуру и Unix и Windows,  имя Host обязательно.

	SID
	SID The name of the Database Instance. If your ClearQuest deployment will include both Unix and Windows clients the SID name is mandatory.

SID название экземпляра базы данных. Если ваше развертывание ClearQuest будет включать клиентуру и Unix и Windows,  имя SID обязательно.

	Server_ver
	Provide the version of the Oracle server you are using. Possible values are 7, 8.0, and 8.1 (For Oracle 8i, use 8.1.)

Обеспечьте версию сервера Oracle, который Вы используете. Возможные значения - 7, 8.0 и 8.1 (Для Oracle 8i используют 8.1.)

	Client_ver
	Provide the version of the Oracle client software you are using. Possible values are 7, 8.0, and 8.1 (For Oracle 8i, use 8.1.)

Обеспечьте версию программного обеспечения пользователя Oracle, которое Вы используете. Возможные значения - 7, 8.0 и 8.1 (Для Oracle 8i используют 8.1.)
If ClearQuest client users want to use a different Oracle client version than what is entered here by the administrator, they’ll need to override the set options manually. The default setting is 7. See Release Notes for details.

Если пользователи ClearQuest client хотят использовать иную версию Oracle client, чем та, что введена здесь администратором, они должны будут отменить параметры установки вручную. Настройка по умолчанию - 7. См. для подробностей Примечания к выпуску.

	Lob_type
	Set the type of data you’ll be using. The valid data type is LONG.

Установите тип данных, которые вы будете использовать. Тип достоверных данных LONG.


Note: All ClearQuest users must use the same SQL*Net Alias (TNSname), Database Instance (system ID or SID), TCP/IP protocol, and Host Name (Oracle server machine).

Примечание: Все пользователи ClearQuest должны использовать одинаковые SQL*Net Alias (TNSname), Database Instance (system ID или SID),  протокол TCP/IP и Host Name (машина сервера Oracle).
4. Мы рекомендуем, чтобы Вы создали пробную базу данных, используя одну из предоставленных схем. Выберите схему, дайте название пробной базе данных, затем нажмите Next.

5. Если Вы создаете пробную базу данных, Вы должны выбрать поставщика и ввести свойства базы данных. Когда Вы закончите, нажмите Next.

6. Вы можете сохранить эти параметры настройки как конфигурацию, заданную по умолчанию, или нажать Finish, чтобы завершить установку. При этом Вы создаете и сохраняете в файл записи профилей входа (заданное по умолчанию название - cqprofile.ini). Клиенты могут соединяться с базой данных,  используя файл конфигурации вместо того, чтобы печатать информацию подключения.

Создание пользовательской базы данных

Вы создаете пользовательские базы данных ClearQuest с использованием ClearQuest Designer, после того, как Вы успешно создали репозиторий схем.

Примечание: Если Вы не используете MS Access, Вы должны сначала создать пустые базы данных поставщика прежде, чем Вы сможете создавать базы данных ClearQuest.

1. В меню Start выберите Programs > Rational ClearQuest > ClearQuest Designer.

2. Нажмите Next, когда появляется диалоговое окно Rational Schema Repository.

3. Нажмите OK, когда появляется диалоговое окно ClearQuest Designer Login.

Примечание: Когда Вы нажмете OK, Вы зарегистрируетесь со значениями имени и пароля, заданными по умолчанию для  администратора ClearQuest. Имя гипотетического пользователя – “ admin”,  пароль должен оставаться пустым. Вы должны изменить этот пароль и создать новую учетную запись для входа в систему, когда этого потребуют обстоятельства.

4. Нажмите Cancel, когда появляется диалоговое окно Open Schema.

5. Выберите Database > New Database.

6. Введите логическое название для создаваемой базы данных. Это название должно содержать пять символов или меньше.

7. Нажмите Next.

8. Выберите базу данных поставщика, которую Вы планируете использовать, введите соответствующие поставщику свойства, затем нажмите Next. Для получения дополнительной информации относительно обязательных параметров для баз данных поставщика, см. шаг 3 раздела “Создание репозитория схем” на странице 21.

9. Нажмите Next.
10. Нажмите Next, чтобы принять заданные по умолчанию запрашиваемые параметры.

11. Выберите схему,  чтобы связать с ней вашу базу данных. Вы должны сопоставить базу данных со схемой.

Предупреждение: Если Вы используете Rational ClearQuest/TeamTest edition, Вы должны выбрать схему TestStudio. Лицензия Rational ClearQuest/TeamTest edition не позволяет Вам использовать другие схемы. Если Вы не выберите схему TestStudio, Вы получите ошибку лицензии.

12. Нажмите Finish.
Установка интеграции с конфигурационным управлением

You can integrate ClearQuest with software configuration management tools to create a complete change management system. ClearQuest relates change requests directly to changes in your evolving code base, allowing you to answer such questions as:

Вы можете интегрировать ClearQuest с инструментальными средствами управления программного обеспечения, чтобы создать законченную систему управления изменениями. ClearQuest связывает запросы изменения непосредственно с изменениями в вашем коде развития базы, давая Вам возможность ответить на такие вопросы как:
Which defects have been fixed in one release but not in another?

Какие дефекты были установлены в одном выпуске, но не в другом?
· Which defects can be attributed to a specific release?

Какие дефекты могут быть приписаны определенному выпуску?
Integrating with Rational ClearCase

Интегрирование с Rational ClearCase
 The integration of ClearQuest and ClearCase allows you to associate change requests with one or more ClearCase elements. To set up the integration:

Интегрирование ClearQuest и ClearCase позволяет Вам связывать запросы изменения с одним или более элементом ClearCase. Чтобы установить интегрирование:
1. Within ClearCase, use the ClearQuest Integration Configuration tool located on the ClearCase Administration menu. The online Help describes how to set up and use the integration.

В пределах ClearCase используйте инструмент ClearQuest Integration Configuration, помещенный в меню ClearCase Administration. Интерактивная справка описывает, как устанавливать и использовать интегрирование.
2. Within ClearQuest, apply the ClearCase package to a schema to enable the integration. For more information on installing packages, see the Administering Rational ClearQuest guide.

В пределах ClearQuest примените пакет ClearCase к схеме, чтобы допустить интегрирование. Для получения дополнительной информации об установке пакетов, см. руководство Администрирование Rational ClearQuest.
Note: If you have a previous installation of ClearQuest that used the ClearCase add-in, select the Upgrade 1.0 version of the ClearCase package. If this is the first time you are installing the integration, use the 1.0 version of the package.

Примечание: Если Вы имеете предыдущую инсталляцию ClearQuest, который использовал включенный ClearCase, выберите версию Upgrade 1.0 пакета ClearCase. Если Вы впервые  устанавливаете интегрирование, используйте версию 1.0 пакета.
Unified Change Management (UCM)

Объединенное управление изменениями (UCM)
To use the ClearQuest/ClearCase UCM integration, consult the following documentation:

Чтобы использовать интегрирование UCM ClearQuest/ClearCase, консультируйтесь со следующей документацией:
· To set up the ClearCase part of the integration and to learn about the UCM process, see the Managing Software Projects with ClearCase guide provided with ClearCase.

Чтобы установить часть ClearCase интегрирования и узнать о процессе UCM, см. руководство  Managing Software Projects with ClearCase, обеспеченное ClearCase.
· To set up the ClearQuest part of the integration, see Appendix B, “Enabling ClearQuest for Unified Change Management,” in the Administering Rational ClearQuest guide.
Чтобы установить часть ClearQuest интегрирования, см. Приложение B, “Предоставление ClearQuest для Unified Change Management ” в руководстве Администрирование Rational ClearQuest.
Integrating with Microsoft Visual SourceSafe

Интегрирование с Microsoft Visual SourceSafe
 The ClearQuest/Visual SourceSafe integration adds Visual SourceSafe fields to a record type you choose, and the Visual SourceSafe tab to the record type form.

Интегрирование ClearQuest/Visual SourceSafe добавляет поля Visual SourceSafe к типу записей, который Вы выбираете, и вкладку Visual SourceSafe к форме типа записей.
To enable the integration:

Чтобы допустить интегрирование:
1. Install ClearQuest and Visual Studio according to the normal procedure for each product.

Установите ClearQuest и Visual Studio согласно нормальной процедуре для каждого изделия.
2. Set up your ClearQuest schema repository and user databases.

Установите ваш репозиторий схем ClearQuest и пользовательские базы данных.
3. Use the ClearQuest Designer to add the Visual SourceSafe integration package to your schema using the Package Wizard.

Используйте ClearQuest Designer, чтобы добавить Visual SourceSafe пакет интегрирования к вашей схеме, используя Package Wizard.
a. Launch the ClearQuest Designer from the Start menu

Запустите ClearQuest Designer из меню Start
b.  Check out the schema you want to use with the integration.

Проверьте схему, которую Вы хотите использовать с интегрированием.
c. Install the Visual SourceSafe package by choosing Package > Package Wizard. Click More Packages to locate the VisualSourceSafe package, then click OK.
Установите пакет Visual SourceSafe,  выбирая Package > Package Wizard. Нажмите More Packages, чтобы разместить пакет VisualSourceSafe, затем нажмите OK.
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d. Select the Visual SourceSafe package and click Next.

Выберите пакет VisualSourceSafe и нажмите Next.
Note: If you have a previous installation of ClearQuest that used the Visual SourceSafe add-in, select the Upgrade 1.0 version of the package. If this is the first time you are installing the integration, use the 1.0 version.

Примечание: Если Вы имеете предыдущую инсталляцию ClearQuest, который использовал включенный Visual SourceSafe, выберите версию Upgrade 1.0 пакета. Если Вы впервые устанавливаете интегрирование, используйте версию 1.0.
e. Select the record types to be enabled by the package, then click Finish.

Выберите типы записей, которые нужно допустить для пакета, затем нажмите Finish.
For more information on packages, consult the Administering Rational ClearQuest guide or the Help for the ClearQuest Designer.

Для получения дополнительной информации о пакетах, консультируйтесь с руководством Админимтрирование Rational ClearQuest или Справкой для ClearQuest Designer.
4. Check in the schema.

Включите схему.
5. Upgrade your user database to the new version of the schema.

Модернизируйте вашу пользовательскую базу данных к новой версии схемы.
Important: We recommend that you first upgrade a test database and familiarize yourself with the integration features before upgrading your production database.

Важно: Мы рекомендуем, чтобы Вы сначала модернизировали испытательную базу данных и ознакомилсь с возможностями интегрирования перед обновлением вашей промышленной базы данных.
6. In ClearQuest, create a query that your end users can use to find the records you want to associate to projects in Visual SourceSafe.

В ClearQuest создайте запрос, который ваши конечные пользователи могут использовать, чтобы найти записи, которые Вы хотите связать спроектами в Visual SourceSafe.
7. On each client that wants to use the integration, launch the ClearQuest Visual Source Safe tool (cqvss.exe) located in the ClearQuest home directory. You can drag a copy of cqvss.exe to the desktop to create a shortcut to it.

На каждом клиенте, который хочет использовать,  интегрирование, запустите инструмент ClearQuest Visual Source Safe (cqvss.exe), размещенный в основном директории ClearQuest. Вы можете перетащить копию cqvss.exe к рабочему столу, чтобы создать для нее ярлык.
8. Log in and select the Visual SourceSafe database you want to use.

Войдите в систему  и выберите базу данных Visual SourceSafe, которую Вы хотите использовать.
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9. From the ClearQuest tools for Visual SourceSafe screen, select Setup Tool.
На  экране ClearQuest tools for Visual SourceSafe выберите Setup Tool.
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10. In the Visual SourceSafe Integration dialog, select the ClearQuest query you want to use and click OK.

В диалоге Visual SourceSafe Integration выберите запрос ClearQuest, который Вы хотите использовать и нажмите OK.
The installation of the integration is complete. To begin using the integration, see the Help for the ClearQuest Visual SourceSafe tool.
Инсталляция интегрирования закончена. Чтобы начать использовать интегрирование, см. Справку для инструмента ClearQuest Visual SourceSafe.
Установка представления записей через электронную почту

Чтобы дать возможность вашим пользователям представлять и изменять записи через электронную почту, Вы конфигурируете Rational E-mail Reader. E-mail Reader – это инструмент, обрабатывающий электронную почту, который анализирует электронную почту представляющего и передает новые записи или изменения в базу данных. E-mail Reader требуется сообщению специализированной электронной почты для синтаксического анализа записей.
Используйте Rational E-mail Reader, чтобы определить одну машину, которая будет сервером (Rational Mail Server). Мы рекомендуем, чтобы Rational Mail Server запускался на машине, которая всегда является доступной.
E-mail Reader (mailreader.exe) автоматически инсталлируется в каталог \Rational\common. Вы можете перетащить копию mailreader.exe на рабочий стол и создать соответствующий ярлык. Далее Вы можете следовать инструкциям в интерактивной справке (она находится в \Rational\common\mailreader.hlp), чтобы установить E-mail Reader. Для получения дополнительной информации о E-mail Reader см. Администрирование электронной почтой ClearQuest в руководстве Администрирование Rational ClearQuest.
Инсталляция Crystal Reports

If you want to customize the defect reports that ship with ClearQuest, you must install Crystal Reports Pro 6.0. This software comes on a separate CD in your Rational ClearQuest software kit.

Если Вы хотите настроить отчеты дефектов, которые работают с ClearQuest, Вы должны установить Crystal Reports Pro 6.0. Это программное обеспечение включено на отдельном CD в вашем инструменте программного обеспечения  Rational ClearQuest.
To install Crystal Reports, use the Crystal Reports installation directions that come with the CD.

Чтобы установить Crystal Reports, используйте инструкции по инсталляции Crystal Reports, которые поставляются с CD.
Note: Users who will not be editing existing or creating new report formats, do not need to install Crystal Reports.

Примечание: Пользователи, которые не будут редактировать существующие или создавать новые форматы отчета, не должны устанавливать Crystal Reports.
You have completed Step 2 of the steps described in “Understanding the install process” on page 9. Return to that page to determine the next step.
Вы выполнили шаг 2 из указаний в “Понимание процесса установки” на странице 9. Возвратитесь к этой странице, чтобы определить следующий шаг.
4. Инсталляция ClearQuest Windows для конечных пользователей

ClearQuest Windows must be installed on each end-user machine. When ClearQuest Windows is installed and connected to the database, users can enter and modify records.

ClearQuest Windows должен быть установлен на каждой машине конечного пользователя. Когда ClearQuest Windows установлен и связан с базой данных, пользователи могут вводить и изменять записи.
Note: It is also possible to allow users to install the ClearQuest Windows client from a network location, for more information see “Silent Installation of Rational ClearQuest” on page 113.

Примечание: также возможно позволить пользователям устанавливать ClearQuest Windows client  от сетевого расположения, для получения дополнительной информации см. “Тихая инсталляция Rational ClearQuest ” на странице 113.
To install ClearQuest Windows for end-users:

Чтобы установить ClearQuest Windows для конечных пользователей:
1. Load the ClearQuest CD-ROM.

Загрузите ClearQuest CD-ROM.
2. If the setup program does not run automatically, navigate to the top level directory of the CD-ROM and double-click setup.exe.

Если установочная программа не выполняется автоматически, перейдите к каталогу верхнего уровня CD-ROM и дважды щелкните setup.exe.
The Rational Software Setup wizard prompts you through the ClearQuest Windows installation.

Мастер Rational Software Setup приглашает Вас к инсталляции ClearQuest Windows.
3. Choose the Client installation.

Выберите инсталляцию Client.
If you will be doing schema development, select the Administrator installation, which includes additional administrative tools.

Если Вы будете развивать схемы, выберите инсталляцию Administrator, которая включает дополнительные административные инструментальные средства.
4. Launch the License Administrator to enter your ClearQuest licenses.
Запустите License Administrator, чтобы ввести ваши лицензии ClearQuest.
Connecting to ClearQuest databases

Соединение с базами данных ClearQuest
 After installing ClearQuest Windows as a client user, the first time client users run ClearQuest Windows, client users need to connect to an existing schema repository. You, the ClearQuest administrator, must provide them database properties information needed.

После установки ClearQuest Windows как пользователя клиента, когда пользователи клиента первый раз запускают ClearQuest Windows, они должны соединиться с существующим репозиторием схем. Вы, администратор ClearQuest, должны обеспечить их необходимой информацией свойств базы данных.
You can create a database profile for client users to use to connect to the schema repository, see step 6 of “Connecting to ClearQuest databases” on page 52.

Вы можете создавать конфигурацию базы данных для пользователей клиента для соединения с репозиторием схем, см. шаг 6 из “Соединение с базами данных ClearQuest ” на странице 52.
Note: If you are using Oracle or DB2, your client users will need to install the respective client software before installing ClearQuest. For more information, see “Configuring an Oracle client installation for ClearQuest Windows” on page 29 or see “Creating a DB2 alias on client machine” on page 35.

Примечание: Если Вы используете Oracle или DB2, ваши пользователи клиента должны будут установить соответствующее программное обеспечение клиента перед установкой ClearQuest. Для получения дополнительной информации, см. “Конфигурация инсталляции клиента Oracle для ClearQuest Windows” на странице 29, или см. “Создание DB2 условного названия на машине пользователя ” на странице 35.
The following instructions apply to client users who need to connect to a schema repository:

Следующие инструкции относятся к пользователям клиента, которые должны соединиться с репозиторием схем:
1. Launch the ClearQuest Maintenance Tool (Start > Programs > Rational ClearQuest > ClearQuest Maintenance Tool).

Запустите ClearQuest Maintenance Tool (Start > Programs > Rational ClearQuest > ClearQuest Maintenance Tool).
Note: The first time you launch ClearQuest Windows, the Maintenance Tool runs automatically.

Примечание: первый раз, когда Вы запускаете ClearQuest Windows, Maintenance Tool выполняется автоматически.
2. Select Connect to Existing schema repository and click Next.

Выберите Connect to Existing schema repository и нажмите Next.
3. Select the vendor database that you plan to use, enter the properties appropriate for that vendor, then click Next.

Выберите базу данных поставщика, которую Вы планируете использовать, введите свойства, соответствующие этому поставщику, затем нажмите Next.
Enter the information provided by your administrator, or, if your ClearQuest administrator created a user profile file (usually called cqprofile.ini) that includes the database information you need, click Load Profile to navigate to the profile file.

Введите информацию, обеспеченную вашим администратором, или, если ваш администратор ClearQuest создал файл параметра пользователя (обычно называемый cqprofile.ini), который включает необходимую Вам информацию базы данных, нажмите Load Profile, чтобы перейти к файлу конфигурации.
If you did not create a profile for client users, they must enter the following information:

Если Вы не создали конфигурацию для пользователей клиента, они должны ввести следующую информацию:
· MS_ACCESS

· Enter the entire path to the schema repository using a UNC style path.

Введите полный путь в репозиторий схем, используя путь стиля UNC.
For example:
Например:
\\DevServer\ProjectShare\CQ_DBS\schema_repo.mdb

You can browse to the directory containing the database. Be sure to browse using the Network Neighborhood to preserve the UNC style path name.

Вы можете просмотреть  каталог, содержащий базу данных. Убедитесь, что просмотрели использование Network Neighborhood, чтобы сохранить имя пути стиля UNC.
· SQL_ANYWHERE

· Enter the path to the schema repository using a UNC style path. For example:

Введите путь в репозиторий схем, используя путь стиля UNC. Например:
\\DevServer\ProjectShare\CQ_DBS\schema_repo.mdb

You can browse to the directory containing the database by using Network Neighborhood, which preserves the UNC style path name.

Вы можете просмотреть  каталог, содержащий базу данных,  используя Network Neighborhood, который сохраняет имя пути стиля UNC.
· Enter the name of the database server.

Введите имя сервера базы данных.
· Enter the protocols used to communicate with the SQL Anywhere server.

Введите протоколы, используемые для связывания с сервером SQL Anywhere.
· Enter the database host name.

Введите имя главной базы данных.
· SQL_SERVER

· Enter an SQL Server database name for the database containing the schema repository.

Введите имя базы данных SQL Server для базы данных, содержащей репозиторий схем.
· Enter the name of the database server.

Введите имя сервера базы данных.
· Enter the schema repository or read-only user login.

Введите репозиторий схем или вход в систему пользователя только для чтения.
· Enter the password for the schema repository or read-only login.

Введите пароль для репозитория схем или входа в систему только для чтения.
· ORACLE

· Enter the SQL*Net Alias (alias pointing to the Oracle instance).

Введите SQL*Net Alias (условное название, указывающее на экземпляр Oracle).
· Enter the Oracle login created for the schema respository.

Введите вход в систему Oracle, созданный для репозитория схем.
· Enter the password for the login.

Введите пароль для входа в систему.
· DB2

· Enter the Database Alias name (alias pointing to the DB2 database).

· Enter the DB2 login created for the schema repository.

· Enter the password for the login.

4. Click Finish to complete the connection.
Нажмите Finish, чтобы завершить подключение.
Разрешение уведомлений электронной почты

После установки ClearQuest Windows, пользователи должен допустить уведомления электронной почты, если они хотят принимать сообщения автоматической электронной почты от ClearQuest Windows. Чтобы селать это:
1. Запустите ClearQuest Windows (Start > Programs > Rational ClearQuest > Rational ClearQuest).

2. Выберите View > E-mail Options. Открывается диалог E-mail Setup.

3. Выберите Enable E-mail Notification.

4. Выберите SMTP или MAPI
5. Если Вы ввели SMTP:

· Введите адрес главного компьютера SMTP вашего сервера почты.

· Введите Ваш электронный адрес.

· Нажмите Finish.

6. Если Вы ввели MAPI:

· Выберите конфигурацию MAPI из списка.

· Нажмите Finish.

5. Инсталляция ClearQuest Unix для конечных пользователей

This chapter describes how to install ClearQuest Unix. You, the ClearQuest administrator, set up the databases to use with ClearQuest, install ClearQuest, and provide the required setup information to each client user.

This chapter covers the following topics:

·  “Understanding the install process” on page 56

·  “Installing ClearQuest Unix client and Oracle Support” on page 57

·  “Running ClearQuest Unix” on page 60

·  “Enabling e-mail notification” on page 61
Understanding the install process

If you plan to use ClearQuest Unix clients with your ClearQuest installation, the installation must include the following:

· Oracle databases (for schema repository and user databases)

· OpenLink Request Broker (facilitates Oracle connections)

· ClearQuest Designer on Windows (for schema development)

· ClearQuest Unix client

You, the ClearQuest administrator, install ClearQuest Unix by performing the following steps:

1. On Unix, set up your database product. As the ClearQuest administrator, you are responsible for setting up the databases your users will use with ClearQuest. See the appropriate section:

· “Setting up the Oracle Server” on page 28.

Note: If your ClearQuest installation will include ClearQuest Unix clients, your vendor database must be Oracle and it must be installed on a Unix server.

2. On Windows, install ClearQuest for Windows on the administrator’s workstation and create the ClearQuest databases. See “Installing ClearQuest for an administrator” on page 37.

Note: The ClearQuest administrator version must be installed on a Windows machine. All ClearQuest customizations are done with the ClearQuest Designer, a Windows-only application.

3. Set up your license server. See “Licensing ClearQuest” on page 111.

4. On Windows, Optionally, customize your installation. See the Administering Rational ClearQuest guide for details on customizing ClearQuest.

5. On Unix, install the ClearQuest Unix client on the server machine from which users will run ClearQuest. See “Installing ClearQuest Unix client and Oracle Support” on page 57.

6. Install OpenLink Request Broker to facilitate Oracle connections. See “Setting up the Oracle OpenLink Request Broker” on page 31.
Installing ClearQuest Unix client and Oracle Support

For ClearQuest Unix, the system administrator needs to install the ClearQuest client software and let all client users know where to find the installation.

To install the ClearQuest client, do the following:

1. Log in as the user who will own the ClearQuest installation. This user will perform administrative functions such as managing the database registry.

Note: All other users only need read-only access to the installation directories.

2. From the ClearQuest CD, run rs_install.

3. Accept the license agreement.

4. Select u)Use existing licensing.

5. Select Configuration Selections.

6. You can choose to install the ClearQuest Client and the OpenLink Request Broker (Oracle Support) all on the same machine as your Oracle installation, or you can install the ClearQuest client on a different machine. The OpenLink Request Broker must be on the same machine as the Oracle server.

7. You must install at least the Oracle Support option now in order to complete the rest of the installation. Select either:

· s1) *ClearQuest Client and Oracle Support for Unix

· s2) *ClearQuest Client-Only for Unix

· s3) *ClearQuest Oracle Support-Only for Unix

8. Enter the directory where Rational products are installed. A ClearQuest directory (referred to here as [CQ_Home]) will be created within the Rational products root directory (referred to here as [Rational_dir]). If the directory does not exist, the install can create it for you as long as you have write privileges to the parent directory.

9. Select the licensing option that allows you to enter a port@host name.

10. Enter the port@hostname name. For example,

27000@server 

where "port" is 27000 and "host" is the name of the Windows license server.

The "host" name needs to be a permanent name; if your network uses DHCP, you may need a variation or special form of the host name. Check with your network administrator.

Note: On HP-UX, “@” may be set to kill the input line. If so, you can escape the “@” with a backslash or just enter the host name.

11. Optionally, you can choose to test the license server at this time. Select option 2) to test the license server. This step may install a small part of the Unix license server software in order to perform the check. If the check fails, you may still proceed with the installation, but you will have to repeat the licensing setup at a later time.

12. Select f) forward to the next menu to continue.

13. Accept the default for the "Customize the install" prompt.

14. Choose the skip option for the "Install mode" prompt.

15. Select f)Forward to do the install.

16. When the installation finishes, you're asked to enter the location of where to store the registry information regarding the schema repository.

Note: This directory must be readable by all machines and users that will run ClearQuest. It must also be writable by the user who will be the ClearQuest administrator.
17. When finished with the installation, add the ClearQuest home directory

[Rational_dir]/ClearQuestClient/bin

to your path or source cq_setup.csh to set the ClearQuest home environment variable ($CQ_HOME):

source [Rational_dir]/cq_setup.csh

18. Type Clearquest to run ClearQuest.

19. The first time you run the ClearQuest/UNIX client, the Register Database dialog displays. Enter the information to connect to the schema repository as described below:

· Enter ORACLE as the vendor.

· Enter the Server name.

· Enter the SID. Note that the SID is case-sensitive.

· Enter the Oracle login and password you created for the schema repository.

· Click Apply.

20. If you need to make changes to Connect Options, connect to the schema repository from the command line and enter:

% cqreg register -v[endor] <db_vendor> -s[erver] <db_server>
-d[database] <database_name> -u[ser] <user> -p[assword] <password>
[-co <connect_options>] <options>

Options include: [-help] [-effort_only] [-force] [-verbose] [-errors]
[-home <cq_home>] [-version <cq_version>] [-cq_databases <cq_databases>]

For <connect options> see the section “Creating ClearQuest databases” on page 39.

For example:

% cqreg register -v oracle -s myserver -d TEST -u cqadmin \
-p cqadmin -co "SERVER_VER=8.0"

Running ClearQuest Unix

You should tell ClearQuest Unix client users where ClearQuest is installed. They can then run ClearQuest directly, or source a configuration file that will modify their path. 

To run ClearQuest Unix,

1. Add the ClearQuest home directory to their path:

[Rational_dir]/ClearQuestClient/bin

or source cq_setup.csh to set the ClearQuest home environment variable ($CQ_HOME):

source [Rational_dir]/cq_setup.csh

2. To run ClearQuest Unix, type clearquest.
Разрешение уведомлений электронной почты

После установки ClearQuest, пользователи должны допустить уведомления электронной почты, если они хотят посылать сообщения автоматической электронной почты из ClearQuest. Чтобы сделать это:
1. Launch ClearQuest. Type ClearQuest at a Unix shell prompt.

2. Within ClearQuest, choose View > E-mail Options. This opens the E-mail Setup dialog.

3. Select Enable E-mail Notification.

4. Enter your e-mail address.

5. Click OK.
6. Установка ClearQuest Web

This chapter describes how to set up the ClearQuest Web server for both Microsoft Internet Information Server version 4 (IIS 4) for Windows NT, and Windows 2000 Server, which includes Microsoft Internet Information Server version 5 (IIS 5).

Эта глава описывает, как установить сервер ClearQuest Web, и для версии 4 Microsoft Internet Information Server для Windows NT, и для Windows 2000 Server, который включает версию 5 Microsoft Internet Information Server version 5 (IIS 5).

This chapter covers the following topics:

Эта глава включает следующие разделы:
·  “Understanding the installation process” on page 64

“Понимание инсталляционного процесса” на странице 64
·  “Setting up ClearQuest Web for IIS 4” on page 65

“Установка ClearQuest Web для IIS 4” на странице 65
·  “Setting Up ClearQuest Web for IIS 5” on page 77

“Установка ClearQuest Web для IIS 5” на странице 77
·  “Enabling e-mail notification for web clients” on page 94

“ Предоставление уведомления электронной почты для клиентуры сети” на странице 94
·  “Providing ClearQuest Web information to web clients” on page 98
“ Обеспечение информация ClearQuest Web для клиентуры сети” на странице 98
Understanding the installation process

Понимание инсталляционного процесса
 The following are special considerations for using ClearQuest Web:

Следующее - специальные обсуждения для использования ClearQuest Web:
· ClearQuest Web does not support Microsoft Access databases.

ClearQuest Web не поддерживает базы данных Microsoft Access.
Your browser must have cookies enabled when using ClearQuest Web.

Ваше окно просмотра должно допускать cookies при использовании ClearQuest Web.
· Make sure your web server is set to display 256 colors. This is necessary for generating charts.

Удостоверьтесь, что ваш сервер сети установлен для отображения 256 цветов. Это необходимо для создания диаграмм.
To install and configure ClearQuest Web on your Windows server, you must complete the following tasks:

Чтобы установить и конфигурировать ClearQuest Web на вашем сервере Windows, Вы должны выполнить следующие задачи:
Note: You must have first set up the vendor database that ClearQuest will use. See “Configuring vendor databases” on page 11.

Примечание: Вы должны были  сначала установить базу данных поставщика, которую будет использовать ClearQuest. См. “Конфигурирование баз данных поставщика” на странице 11.
1. If you are using Windows NT and want to use IIS 4.0, verify that Windows NT 4.0 Option Pack, which includes Microsoft Internet Information Server 4.0 (IIS), is installed on your web server.

Если Вы используете Windows NT и хотите использовать IIS 4.0, проверьте, что Windows NT 4.0 Option Pack, который включает Microsoft Internet Information Server 4.0 (IIS), установлен на вашем сервере сети.
2. Install ClearQuest on the Web server. See, “Installing ClearQuest for an administrator” on page 37.

Установите ClearQuest на сервере Web. См. “Инсталляция ClearQuest для администратора” на странице 37.
Note: We recommend, for improved performance, security, and reliability, that the Web server machine and the database server machine be two different machines, each with its software installed onto an NTFS partition.

Примечание: Мы рекомендуем для улучшения эффективности, защиты и надежности, чтобы машина сервера Web и машина сервера базы данных – были двумя различными машинами, каждая со своим программным обеспечением, установленным на раздел NTFS.
3. Follow the instructions in this chapter to configure Microsoft Internet Information Server to serve the ClearQuest Web pages.

Следуйте инструкциям в этой главе, чтобы конфигурировать Microsoft Internet Information Server для обслуживания страниц ClearQuest Web.
4. Configure the web server so that web clients can take advantage of ClearQuest’s e-mail notification feature.

Конфигурируйте сервер сети так, чтобы клиентура сети могла воспользоваться преимуществом возможности уведомления электронной почты ClearQuest.
5. Provide users with the path to ClearQuest Web.
Обеспечьте пользователей путем к ClearQuest Web.
Setting up ClearQuest Web for IIS 4

Установка ClearQuest Web для IIS 4
This section is for users using Windows NT (Workstation or Server) with IIS 4. If you are using Windows 2000 Server, which has IIS 5 as an embedded component, see “Setting Up ClearQuest Web for IIS 5” on page 77.

Этот раздел - для пользователей, использующих Windows NT (Workstation или Server) с IIS 4. Если Вы используете Windows 2000 Server, который имеет IIS 5 как внедренный компонент, см. “Установка ClearQuest Web для IIS 5” на странице 77.
This section contains the following:

Этот раздел содержит следующее:
·  “Setting up an anonymous user account for IIS 4” on page 65

“Установка учетной записи анонимного пользователя для IIS 4” на странице 65
·  “Creating a cache directory for IIS 4” on page 68

“Создание каталога кэша для IIS 4” на странице 68
·  “Configuring IIS 4.0 to serve ClearQuest Web pages” on page 69

“Конфигурирование IIS 4.0 для обслуживания страницы ClearQuest Web” на странице 69
Setting up an anonymous user account for IIS 4

Установка учетной записи анонимного пользователя для IIS 4
Create an anonymous user account for IIS to use when it serves the ClearQuest pages. If you are using an SQL Server database, the anonymous user account should be known in the domain that contains the ClearQuest database, and should have full access to that database.

Создайте учетную запись анонимного пользователя для IIS, чтобы применять ее, когда он использует страницы ClearQuest. Если Вы используете базу данных SQL Server, учетная запись анонимного пользователя должна быть известна в домене, который содержит базу данных ClearQuest, и должна иметь полный доступ к этой базе данных.
Create the anonymous user account

Создание учетной записи анонимного пользователя
 Create the anonymous user account as follows:

Создайте учетную запись анонимного пользователя следующим образом:
1. Log on as a Windows NT administrator.

Войдите как администратор Windows NT.
2. If the web server belongs to a Windows NT domain, ask your Windows NT system administrator to create a domain user and provide you with the user name and password. (If not, go to Step 4.)

Если сервер сети принадлежит домену Windows NT, попросите, чтобы ваш системный администратор Windows NT создал пользователя домена и обеспечил Вас именем пользователя и паролем. (Если нет, перейдите к шагу 4.)
3. Run the User Manager (Start > Programs > Administrative Tools > User Manager), select Policies > User Rights, select the Show Advanced Rights checkbox, and give this user the following privileges on the Web server:

Запустите User Manager (Start > Programs > Administrative Tools > User Manager), выберите Policies > User Rights, выберите переключатель Show Advanced Rights, и дайте этому пользователю следующие привилегии на сервере Web:
· Access this computer from network (Доступ к этому компьютеру от сети)
·  Log on locally (Локальный вход)
·  Log on as a service (Вход как обслуживание)
 Also provide access to any other resources used by your hook scripts such as mail accounts or auxiliary databases. Skip to Step 6.
Также обеспечьте доступ к любым другим ресурсам, используемым вашими сценариями обработчика прерываний, типа учета почты или вспомогательных баз данных. Перейдите к шагу 6.
4. If the web server operates in stand-alone mode (does not belong to a Windows NT domain), use the default anonymous account created by the IIS installation (IUSR_<machine_name>) for Step 5.

Если сервер сети оперирует в автономном режиме (не принадлежит домену Windows NT), используйте заданный по умолчанию анонимный учет, созданный инсталляцией IIS (IUSR_<machine_name >) в шаге 5.
5. Run the User Manager (Start > Programs > Administrative Tools > User Manager), select Policies > User Rights, select the Show Advanced Rights checkbox, and give the IUSR_<machine_name> account the following privileges:

Запустите User Manager (Start > Programs > Administrative Tools > User Manager), выберите Policies > User Rights, выберите переключатель Show Advanced Rights и дайте IUSR_<machine_name> следующие привилегии:
· Access this computer from network (Доступ к этому компьютеру от сети)
·  Log on locally (Локальный вход)
· Log on as a service (Вход как обслуживание)
 Also provide access to any other resources used by your hook scripts such as mail accounts or auxiliary databases.

Также обеспечьте доступ к любым другим ресурсам, используемым вашими сценариями обработчика прерываний, типа учета почты или вспомогательных баз данных.
6. Verify that the anonymous user account has a specific, known password (you will need it later). Make sure there are no password policies in effect such as “User must change password at next login,” because these prevent the anonymous user account from functioning properly.
Проверьте, что учетная запись анонимного пользователя имеет определенный, известный пароль (Вы будете нуждаться в этом позже). Удостоверьтесь, что не имеется никаких защит для пароля, типа “Пользователь должен изменить пароль при следующем входе в систему”, потому что они не позволяют учетной записи анонимного пользователя функционировать должным образом.
Set up the registry key access privileges

Установка привилегий доступа ключа регистрации
 Give the anonymous user account full access privileges to the

Дайте учетной записи анонимного пользователя полные привилегии доступа, чтобы
 HKEY_LOCAL_MACHINE\Software\Rational Software\ClearQuest

registry key as follows.

регистрировать ключ следующим образом.
1. Select Run from the Start menu and type REGEDT32 to run the REGEDT32 program.

Выберите Run из меню Start и напечатайте REGEDT32, чтобы выполнить программу REGEDT32.
2. In the HKEY_LOCAL_MACHINE MDI window, select Software\Rational Software\ClearQuest.

В окне HKEY_LOCAL_MACHINE MDI выберите Software\Rational Software\ClearQuest.
3. On the Registry Editor menu bar, select Security > Permissions.

В строке меню Registry Editor выберите Security > Permissions.
4. In the Registry Key Permissions dialog box, select the anonymous user. For the type of access, select Full Control. Select Replace Permission on Existing Subkeys so that the anonymous user can update the entire registry tree below ClearQuest.

В диалоговом окне Registry Key Permissions выберите анонимного пользователя. Для типа доступа выберите Full Control. Выберите Replace Permission on Existing Subkeys так, чтобы анонимный пользователь мог модифицировать полное дерево системных реестров ниже ClearQuest.
5. Close the REGEDT32 program.

Закройте программу REGEDT32.
Set up read access permission

Установка разрешение доступа для чтения
 Give the anonymous user account read access permission to the directory tree containing the ClearQuest web files (this is the WWW directory in the ClearQuest installation area).

Дайте анонимному пользователю разрешение доступа для чтения учетной записи дерева каталогов, содержащего файлы ClearQuest сети (это - каталог WWW в области инсталляции ClearQuest).
Note: If you installed ClearQuest onto a FAT partition instead of an NTFS partition, you will not see a Security tab and can skip this section.

Примечание: Если Вы установили ClearQuest на раздел FAT вместо раздела NTFS, Вы не увидите вкладку Security и можете пропустить этот раздел.
1. Use the Windows Explorer to locate the directory in which you installed ClearQuest. Right-click the www directory and select Properties from the shortcut menu.

Используйте Windows Explorer, чтобы разместить каталог, в который Вы установили ClearQuest. Щелкните правой кнопкой мыши каталог www и выберите Properties из контекстного меню.
2. On the Properties dialog box, click the Security tab. Click Permissions and select Replace Permissions on Subdirectories.

В диалоговом окне Properties нажмите вкладку Security. Нажмите Permissions и выберите Replace Permissions on Subdirectories.
3. On the Directory Permissions dialog box, click Add.
В диалоговом окне Directory Permissions нажмите Add.
4. Select the anonymous user account.

Выберите учетную запись анонимного пользователя.
· If you chose the default local anonymous username in Step 2, set List Names From to the name of the local machine, click Show Users below the Names list, then select the IUSR_machinename account from the Names list.

Если Вы выбрали заданное по умолчанию локальное имя анонимного пользователя в шаге 2, установите List Names From для имени локальной машины, нажмите Show Users ниже списка Names, затем выберите IUSR_machinename из списка Names.
· If you are using a domain account, select that domain in the List Names From field, click Show Users, and select the domain account from the Names list.

Если Вы используете домен учета, выберите этот домен в поле List Names From, нажмите Show Users и выберите домен учета из списка Names.
5. Click Add.

Нажмите Add.
6. Set Type of Access to Read.

Установите Type of Access к Read.
7. Click OK to close the Add Users and Groups dialog box.

Нажмите OK, чтобы закрыть диалоговое окно Add Users and Groups.
8. Click OK to close the Directory Permissions dialog box.

Нажмите OK, чтобы закрыть диалоговое окно Directory Permissions.
9. Click OK to close the WWW Properties dialog box.

Нажмите OK, чтобы закрыть диалоговое окно WWW Properties.
Creating a cache directory for IIS 4

Создание каталога кэша для IIS 4
Create a cache directory in the ClearQuest Web directory hierarchy:

Создайте каталог кэша в иерархии каталогов ClearQuest Web:
1. At the top of the web directory tree, there should be a directory called cache. If a cache directory does not exist, create one under the ClearQuest WWW directory. For example:

Наверху дерева каталогов сети должен иметься каталог, называемый cache. Если каталог cache не существует, создайте его под каталогом ClearQuest WWW. Например:
c:\Program Files\Rational\ClearQuest\WWW\cache

2. Give the anonymous user full access to everything in this directory tree.
Дайте анонимному пользователю полный доступ ко всему в этом дереве каталогов.
Configuring IIS 4.0 to serve ClearQuest Web pages

Конфигурирование IIS 4.0 для обслуживания страниц ClearQuest Web
 This section describes how to configure the IIS 4.0 web server to serve ClearQuest Web pages.

Этот раздел описывает, как конфигурировать сервер сети IIS 4.0, чтобы обслуживать страницы ClearQuest Web.
·  “Create a virtual directory for IIS 4” on page 69

“Создание виртуального каталога для IIS 4” на странице 69
 “Edit the properties of the virtual directory for IIS 4” on page 72

“Редактирование свойств виртуального каталога для IIS 4” на странице 72
·  “Edit the properties of the cache directory for IIS 4” on page 75

“Редактирование свойств каталога кэша для IIS 4” на странице 75
·  “Edit the properties of the images directory for IIS 4” on page 76

“Редактирование свойств каталога изображений для IIS 4” на странице 76
·  “Restart the web server for IIS 4” on page 76

“ Перезагрузка сервера сети для IIS 4” на странице 76
Note: If the Internet Service Manager is not available, you must install the Windows NT 4.0 Option Pack. When installing the Option pack, be sure to explicitly select the Internet Service Manager.

Примечание: Если Internet Service Manager не доступен, Вы должны установить Windows NT 4.0 Option Pack. При установке Option pack, убедитесь, что явно выбрали Internet Service Manager.
Create a virtual directory for IIS 4

Создание виртуального каталога для IIS 4
The first step in setting up IIS 4.0 is to create a virtual directory for the web. To create this directory, you use the Internet Service Manager program (Microsoft Management Console) that comes with IIS 4.0.

Первый шаг в установке IIS 4.0 должен создать виртуальный каталог для сети. Чтобы создать этот каталог, Вы используете программу Internet service manager (Microsoft Management Console), которая поступает с IIS 4.0.
1. Start the Microsoft Management Console program (Internet Service Manager).

Запустите программу Microsoft Management Console (Internet Service Manager).
Start > Programs > Windows NT 4.0 Option Pack > Microsoft Internet Information Server > Internet Service Manager.
2. In the Navigator window, right-click Default Web Site, then click New > Virtual Directory from the shortcut menu.

В окне Navigator щелкните правой кнопкой мыши Default Web Site, затем нажмите New > Virtual Directory в контекстном меню.
<fig> In the Navigator window, right-click Default Web Site.

<Рис.> В окне Navigator щелкните правой кнопкой мыши Default Web Site.
3. In the New Virtual Directory Wizard, type an alias name, such as CqWeb. Do not use a “/” character in the alias name.

В New Virtual Directory Wizard напечатайте условного имя, типа CqWeb. Не используйте символ “/” в условном имени.
<fig> Type an alias name 
         Click Next
<Рис.> Напечатайте условное имя 

         Нажмите Next
4.  Type or browse to the name of the directory containing the ClearQuest Web files. These files are located in the WWW subdirectory of the ClearQuest installation directory. For example:

Напечатайте или просмотрите  имя каталога, содержащего файлы ClearQuest Web. Эти файлы зафиксированы в подкаталоге WWW каталога инсталляции ClearQuest. Например:
C:\Program Files\Rational\ClearQuest\WWW

<fig> Type the name of the directory containing the ClearQuest Web file
         Click Next
<Рис.> Напечатайте имя каталога, содержащего файл ClearQuest Web
         Нажмите Next
5.  Select the default permissions for the virtual directory:

Выберите заданные по умолчанию разрешения для виртуального каталога:
<fig> Select Allow Execute Access (includes Script Access)
         Click Finish
<рис.> Выберите Allow Execute Access (includes Script Access)
         Нажмите Finish
 Edit the properties of the virtual directory for IIS 4

Редактирование свойств виртуального каталога для IIS 4
Edit the properties of the virtual directory as follows:

Редактируйте свойства виртуального каталога следующим образом:
1. In the Microsoft Management Console left pane, navigate to the virtual directory you created earlier.

В Microsoft Management Console оставив область окна, передвигайтесь к виртуальному каталогу, который Вы создали ранее.
2. Right-click on the virtual directory and select Properties from the shortcut menu.

Щелкните правой кнопкой мыши на виртуальном каталоге и выберите Properties из контекстного меню.
3. In the Properties dialog box, click the Virtual Directory tab.

В диалоговом окне Properties нажмите вкладку Virtual Directory.
Note: You should not run ClearQuest Web in a separate memory space (as an isolated process). If you do so, e-mail rules will not work. If you need to run ClearQuest Web in a separate memory space, see the ClearQuest Release Notes (\\ClearQuest\readme.htm) for more information.

Примечание: Вы не должны выполнять ClearQuest Web в отдельном пространстве памяти (как изолированный процесс). Если Вы сделаете это, правила электронной почты не будут работать. Если Вы должны выполнить ClearQuest Web в отдельном пространстве памяти, см. ClearQuest Release Notes (\\ClearQuest\readme.htm) для получения дополнительной информации.
<fig> Clear all of these boxes)
         Select Execute (including script)
<Рис.> Очистите все эти блоки
         Выберите Execute (including script)
4. In the same Properties dialog box, click Configuration. In the Application Configuration dialog, click the App Mappings tab.

В том же диалоговом окне Properties нажмите Configuration. В диалоге Application Configuration нажмите вкладку App Mappings.
<fig> Verify that Cache ISAPI applications is selected
         Verify that .asa and .asp are mapped to asp.dll
<Рис.> Убедитесь, что Cache ISAPI applications выбрано
         Убедитесь, что .asa и .asp отображены к asp.dll 
5.  In the same Application Configuration dialog box, click the App Options tab.

В том же диалоговом окне Application Configuration нажмите вкладку App Options.
<fig> Select Enable session state and set the timeout
         Select Enable parent paths
<рис.> Выберите Enable session state и установите время ожидания
         Выберите Enable parent paths
6.  Click OK to return to the Properties dialog box.

Нажмите OK, чтобы вернуться к диалоговому окну Properties.
7. In the Properties dialog box, click the Documents tab.

В диалоговом окне Properties нажмите вкладку Documents.
<fig> If necessary, add the Default.asp document to the list of documents...
           then remove any other documents and select Default.asp as the default
         Click to add the Default.asp document to the list
<Рис.> В случае необходимости, добавьте документ Default.asp к списку документов ...
           затем удалите любые другие документы и выберите Default.asp как значение по умолчанию

         Щелкните, чтобы добавить документ Default.asp к списку
8.  In the same Properties dialog box, click the Directory Security tab. In the Anonymous Access and Authentication Control, click Edit to open the Authentication Methods dialog box.

В том же диалоговом окне Properties нажмите вкладку Directory Security. В Anonymous Access and Authentication Control нажмите Edit, чтобы открыть диалоговое окно Authentication Methods.
<fig> Select Allow Anonymous Access
           Important: Verify that Windows NT Challenge/Response is NOT selected. If the box has a check mark, be sure to clear it
         Then click Edit to define the anonymous user account
<рис.> Выберите Select Allow Anonymous Access
           Важно: Убедитесь, что  Windows NT Challenge/Response НЕ выбран. Если блок имеет галочку, убедитесь, что очистили его

         Затем нажмите Edit, чтобы определить учетную запись анонимного пользователя
9.  Define the anonymous user account:

Определите учетную запись анонимного пользователя:
<fig> Select the anonymous user account created on page 65
         Clear Enable Automatic Password Synchronization and type the password

<рис.> Выберите учетную запись анонимного пользователя, созданную на странице 65
         Очистите Enable Automatic Password Synchronization и напечатайте пароль
 Note: ClearQuest Web does not work if Enable Automatic Password Synchronization is selected.

Примечание: ClearQuest Web не работает, если Enable Automatic Password Synchronization  выбран.
10. Click OK.

Нажмите OK.
11. Type the password in the Confirm Password dialog box and click OK.

Напечатайте пароль в диалоговом окне Confirm Password и нажмите OK.
12. Click OK again to close the Properties dialog.

Нажмите OK снова. чтобы закрыть диалог Properties.
Edit the properties of the cache directory for IIS 4

Редактирование свойств каталога кэша для IIS 4
Edit the properties of the cache subdirectory as follows:

Редактируйте свойства подкаталога кэша следующим образом:
1. In the Microsoft Management Console left pane, navigate to the cache directory under the virtual directory name.

В Microsoft Management Console оставьте область окна, передвигайтесь к каталогу кэша под  именем виртуального каталога.
2. Right-click the cache directory.

Щелкните правой кнопкой мыши каталог cache.
3. Click Properties from the shortcut menu.

Нажмите Properties в контекстном меню.
4. In the Properties dialog box, click the Directory tab.

В диалоговом окне Properties нажмите вкладку Directory.
5. For Access Permissions, select only Read. Verify that no other options are selected.

Для Access Permissions выберите только Read. Убедитесь, что никакие другие параметры не выбраны.
6. For Permissions, select None.

Для Permissions выберите None.
7. Click OK.

Нажмите OK.
Edit the properties of the images directory for IIS 4

Редактирование свойств каталога изображений для IIS 4
Edit the properties of the images subdirectory as follows:

Редактируйте свойства подкаталога изображений следующим образом:
1. In the Navigator window of the Microsoft Management Console, expand the directory tree of the Default Web Site until you locate the images directory under your alias name.

В окне Navigator в Microsoft Management Console разверните дерево каталогов Default Web Site, до того, как расположите каталог изображений под вашим условным именем.
2. Right-click the images directory.

Щелкните правой кнопкой мыши каталог images.
3. Click Properties from the shortcut menu.

Нажмите Properties в контекстном меню.
4. In the Properties dialog box, click the Directory tab.

В диалоговом окне Properties нажмите вкладку Directory.
5. For Access Permissions, select only Read. Verify that no other options are selected.

Для Access Permissions выберите только Read. Убедитесь, что никакие другие параметры не выбраны.
6. For Permissions, select None.

Для Permissions выберите None.
7. Click OK.

Нажмите OK.
Restart the web server for IIS 4

Перезагрузка сервера сети для IIS 4
Close the Microsoft Management Console, saving your console settings, then restart the web server.

Закройте Microsoft Management Console, сохранив ваши пультовые параметры настройки, затем перезагрузите сервер сети.
You have completed installing and configuring the ClearQuest web server for IIS 4.
Вы завершили установку и конфигурирование сервера сети ClearQuest для IIS 4.
Setting Up ClearQuest Web for IIS 5

Установка ClearQuest Web для IIS 5
This section describes how to set up the ClearQuest Web server for Windows 2000 Server, which includes Microsoft Internet Information Server version 5 as an embedded component. If you are using Windows NT, see “Setting up ClearQuest Web for IIS 4” on page 65.

Этот раздел описывает, как установить сервер ClearQuest Web для Windows 2000 Server, который включает версию 5 Microsoft Internet Information Server как внедренный компонент. Если Вы используете Windows NT, см. “Установка ClearQuest Web для IIS 4” на странице 65.
This section contains the following:

Этот раздел содержит следующее:
·  “Setting up an anonymous user account for IIS 5” on page 77

“Установка учетной записи анонимного пользователя для IIS 5” на странице 77
·  “Creating a cache directory for IIS 5” on page 81

“Создание каталога кэша для IIS 5” на странице 81
·  “Configuring IIS 5 to serve ClearQuest Web pages” on page 83

“Конфигурирование IIS 5 для обслуживания страниц ClearQuest Web” на странице 83
Setting up an anonymous user account for IIS 5

Установка учетной записи анонимного пользователя для IIS 5
Create an anonymous user account for IIS to use when it serves the ClearQuest pages. If you are using an SQL Server database, the anonymous user account should be known in the domain that contains the ClearQuest database, and should have full access to that database.

Создайте учетную запись анонимного пользователя для IIS, чтобы использовать ее при обслуживании страниц ClearQuest. Если Вы используете базу данных SQL Server, учетная запись анонимного пользователя должна быть известна в домене, который содержит базу данных ClearQuest, и необходимо иметь полный доступ к этой базе данных.
Create the anonymous user account

Создание учетной записи анонимного пользователя
 Create the anonymous user account as follows:

Создайте учетную запись анонимного пользователя следующим образом:
1. Log on as a Windows 2000 administrator.

Войдите как администратор Windows 2000.
2. If the web server belongs to a Windows domain, ask your Windows system administrator to create a domain user and provide you with the user name and password. (If not, go to Step 4.)

Если сервер сети принадлежит домену Windows, попросите, чтобы ваш системный администратор Windows создал домен пользователя и обеспечил Вас именем пользователя и паролем. (Если нет, перейдите к шагу 4.)
3. For this domain user, click Start > Programs > Administrative Tools > Local Security Policy, select Local Policies > User Rights Assignment. For each of the following double-click to view the Local Security Setting dialog box then use the Add button to grant this user the following privileges on the Web server:

В этом домена пользователя нажмите Start > Programs > Administrative Tools > Local Security Policy, select Local Policies > User Rights Assignment, выберите Local Policies > User Rights Assignment. Используйте двойной щелчок, чтобы рассмотреть диалоговое окно Local Security Setting, затем используйте кнопку Add, чтобы предоставить этому пользователю следующие привилегии на сервере Web:
· Access this computer from network (Доступ к этому компьютеру от сети)
·  Log on as a service (Вход как обслуживание)
·  Log on locally (Локальный вход)
 Also provide access to any other resources used by your hook scripts, such as mail accounts. (Go to Step 6.).
Также обеспечьте доступ к любым другим ресурсам, используемым вашими сценариями обработчика прерываний, типа отчетности почты. (перейдите к шагу  6.).
4. If the web server operates in stand-alone mode (does not belong to a Windows NT domain), use the default anonymous account created by the IIS installation (IUSR_<machine_name>). Click Start > Programs > Administrative Tools > Local Security Policy, select Local Policies > User Rights Assignment, and use the Add button to grant this user the following privileges on the Web server:

Если сервер сети оперирует в автономном режиме (не принадлежит домену Windows NT), используйте заданный по умолчанию анонимный учет, созданный инсталляцией IIS (IUSR_<machine_name >). Нажмите Start > Programs > Administrative Tools > Local Security Policy, выберите Local Policies > User Rights Assignment, и используйте кнопку Add, чтобы предоставить этому пользователю следующие привилегии на сервере Web:
· Access this computer from network (Доступ к этому компьютеру от сети)
·  Log on as a service (Вход как обслуживание)
· Log on locally (Локальный вход)

Also provide access to any other resources used by your hook scripts, such as mail accounts.

Также обеспечьте доступ к любым другим ресурсам, используемым вашими сценариями обработчика прерываний, типа отчетности почты.
5. Verify that the anonymous user account has a specific, known password (you will need it later). Make sure there are no password policies in effect such as “User must change password at next login,” because these prevent the anonymous user account from functioning properly.
Проверьте, что учетная запись анонимного пользователя имеет специальный, известный пароль (Это Вам понадобится позже). Удостоверьтесь, что не имеется никаких защит пароля  типа “Пользователь должен изменить пароль при следующем входе в систему”, потому что они не позволяют учетной записи анонимного пользователя функционировать должным образом.
Set up registry key access privileges

Установка привилегий доступа ключа регистрации
 Give the anonymous user account full access privileges to the 

Дайте учетной записи анонимного пользователя полные привилегии доступа, 
 HKEY_LOCAL_MACHINE\Software\Rational Software\ClearQuest

registry key as follows.

чтобы регистрировать ключ следующим образом.
1. Select Run from the Start menu and type REGEDT32 to run the REGEDT32 program.

Выберите Run из меню Start и напечатайте REGEDT32, чтобы выполнить программу REGEDT32.
2. In the HKEY_LOCAL_MACHINE MDI window, select Software\Rational  Software\ClearQuest.

В окне HKEY_LOCAL_MACHINE MDI выберите Software\Rational Software\ClearQuest.
3. On the Registry Editor menu bar, select Security > Permissions.

В строке меню Registry Editor выберите Security > Permissions.
4. In the Registry Key Permissions dialog box, select the anonymous user. For the Permissions, select Full Control.

В диалоговом окне Registry Key Permissions выберите анонимного пользователя. Для Permissions выберите Full Control.
5. Select Allow inheritable permissions.

Выберите Allow inheritable permissions.
<fig> Select Allow inheritable
<рис.> Выберите Allow inheritable
6.  Close the REGEDT32 program.

Закройте программу REGEDT32.
Set up read access permission

Установка разрешения доступа для чтения
 Give the anonymous user account read access permission to the directory tree containing the ClearQuest web files (this is the WWW directory in the ClearQuest installation area).

Дайте разрешение доступа для чтения учетной записи анонимного пользователя дереву каталогов, содержащему файлы сети ClearQuest (это - каталог WWW в области инсталляции ClearQuest).
Note: If you installed ClearQuest onto a FAT partition instead of an NTFS partition, you will not see a Security tab and can skip this section.

Примечание: Если Вы установили ClearQuest на раздел FAT вместо раздела NTFS, Вы не увидите вкладку Security и можете пропустить этот раздел.
1. Use the Windows Explorer to locate the directory in which you installed ClearQuest. Right-click the www directory and select Properties from the shortcut menu.

Используйте Windows Explorer, чтобы расположить каталог, в который Вы установили ClearQuest. Щелкните правой кнопкой мыши каталог www и выберите Properties из контекстного меню.
2. On the Properties dialog box, click the Security tab and select Allow inheritable permissions.

В диалоговом окне Properties нажмите вкладку Security и выберите Allow inheritable permissions.
<fig> Select Allow inheritable
<рис.> Выберите Allow inheritable
3.  On the Security tab, click Add.

На вкладке Security нажмите Add.
4. Select the anonymous user account.

Выберите учетную запись анонимного пользователя.
· If you chose the default local anonymous username in Step 2, set Look in to the name of the local machine, then select the IUSR_machinename account from the Name list.

Если Вы выбрали заданное по умолчанию локальное анонимное имя пользователя в шаге 2, установите Look in  к названию локальной машины, затем выберите IUSR_MACHINENAME из списка Name.
· If you are using a domain account, select that domain in the Look in field, and select the domain account from the Name list.

Если Вы используете домен учета, выберите этот домен в поле Look in и выберите домен учета из списка Name.
5. Click Add, then click OK.

Нажмите Add, затем нажмите OK.
6. On the Security tab, in the Permissions section, select the checkbox to allow Read, then click OK.

На вкладке Security в разделе Permissions выберите переключатель, чтобы допустить Read, затем нажмите OK.
Creating a cache directory for IIS 5

Создание каталога кэша для IIS 5
Create a cache directory in the ClearQuest Web directory hierarchy.

Создайте каталог кэша в иерархии каталогов ClearQuest Web.
Note: If you installed ClearQuest onto a FAT partition instead of an NTFS partition, you will not see a Security tab and can skip this section.

Примечание: Если Вы установили ClearQuest на раздел FAT вместо раздела NTFS, Вы не увидите вкладку Security и можете пропустить этот раздел.
1. At the top of the web directory tree, there should be a directory called cache. If a cache directory does not exist, create one your ClearQuest WWW directory. For example:

Наверху дерева каталогов сети должен иметься каталог, называемый кэшем. Если каталог кэша не существует, создайте один ваш каталог ClearQuest WWW. Например:
c:\Program Files\Rational\ClearQuest\WWW\cache

2.  Right-click the cache directory to see its properties.

Щелкните правой кнопкой мыши каталог кэша, чтобы увидеть его свойства.
3. On the Properties dialog box, click the Security tab..82 Installing Rational ClearQuest

В диалоговом окне Properties нажмите вкладку Security .. 82 Installing Rational ClearQuest 
4.  Select the anonymous user account.

Выберите учетную запись анонимного пользователя.
· If you chose the default local anonymous username in Step 2, set Look in to the name of the local machine, then select the IUSR_machinename account from the Name list.

Если Вы выбрали заданное по умолчанию локальное анонимное имя пользователя в шаге 2, установите Look in к названию локальной машины, затем выберите учет IUSR_MACHINENAME из списка Name.
· If you are using a domain account, select that domain in the Look in field, and select the domain account from the Name list.

Если Вы используете домена учета, выберите этот домен в поле Look in, и выберите домен учета из списка Name.
5. Click Add, then click OK.

Нажмите Add, затем нажмите OK.
6. In the Permissions section, select the checkbox to allow Full Control, then click OK.
В разделе Permissions выберите переключатель, чтобы допустить Full Control, затем нажмите OK.
Configuring IIS 5 to serve ClearQuest Web pages

Конфигурирование IIS 5 для обслуживания страниц ClearQuest Web
 This section describes how to configure the IIS 5 web server to serve ClearQuest Web pages.

Этот раздел описывает, как конфигурировать сервер сети IIS 5 для обслуживания страниц ClearQuest Web.
·  “Create a virtual directory for IIS 5” on page 83

“Создание виртуального каталога для IIS 5” на странице 83
·  “Edit the properties of the virtual directory for IIS 5” on page 87

“Редактирование свойств виртуального каталога для IIS 5” на странице 87
·  “Editing the properties of the cache directory for IIS 5” on page 92

“Редактирование свойств каталога кэша для IIS 5” на странице 92
·  “Edit the properties of the images directory for IIS 5” on page 92

“ Редактирование свойств каталога изображений для IIS 5” на странице 92
·  “Restart the web server for IIS 5” on page 93

“ Перезагрузка сервера сети для IIS 5” на странице 93
Create a virtual directory for IIS 5

Создание виртуального каталога для IIS 5
Create a virtual directory for the web as follows.

Создайте виртуальный каталог для сети следующим образом.
1. Start the Internet Services Manager.

Запустите Internet Services Manager.
Start > Programs > Administrative Tools > Internet Services Manager

2.  In the Navigator window, right-click Default Web Site..84 Installing Rational ClearQuest

В окне Navigator щелкните правой кнопкой мыши Default Web Site..84 Installing Rational ClearQuest
3.  On the shortcut menu, click New > Virtual Directory.

В контекстном меню нажмите New > Virtual Directory.
<fig> In the Navigator window, right-click Default Web Site.
<Рис.> В окне Navigator щелкните правой кнопкой мыши Default Web Site.
4. Click Next when the Virtual Directory Creation Wizard appears.

Нажмите Next, когда появится Virtual Directory Creation Wizard.
5. Type an alias name, such as CqWeb. Do not use a “/” character in the alias name. Then click Next.

Напечатайте условное имя, типа CqWeb. Не используйте символ “/” в условном имени. Затем нажмите Next.
<fig> 

<Рис.> 
6. Type or browse to the name of the directory containing the ClearQuest Web files. These files are located in the WWW subdirectory of the ClearQuest installation directory. For example:

Напечатайте или просмотрите имя каталога, содержащего файлы ClearQuest Web. Эти файлы зафиксированы в подкаталоге WWW каталога инсталляции ClearQuest. Например:
C:\Program Files\Rational\ClearQuest\WWW

 <fig> Type (or browse to) the directory containing the ClearQuest Web file
           Then click Next
Тип <рис.> Напечатайте (или просмотрите) каталог, содержащий файл ClearQuest Web
           Затем нажмите Next
7.  Clear Read, clear Run scripts, and select Execute. Then click Next.

Очистите Read, очистите Run scripts и выберите Execute. Затем нажмите Next.
<fig> Select Execute, and verify that nothing else is selected
           Then click Next
<рис.> Выберите Execute и убедитесь, что ничто иное не выбрано
           Затем нажмите Next
8.  Click Finish to complete the Wizard.

Нажмите Finish, чтобы завершить Wizard.
Edit the properties of the virtual directory for IIS 5

Редактирование свойств виртуального каталога для IIS 5
Edit the properties of the virtual directory as follows:

Редактируйте свойства виртуального каталога следующим образом:
1. In the Internet Information Services left pane, navigate to the virtual directory you created earlier.

В левой части окна Internet Information Services перейдитек виртуальному каталогу, который Вы создали ранее.
2. Right-click on the virtual directory and select Properties from the shortcut menu.

Щелкните правой кнопкой мыши на виртуальном каталоге и выберите Properties из контекстного меню.
3. In the Properties dialog box, click the Virtual Directory tab.

В диалоговом окне Properties нажмите вкладку Virtual Directory.
<fig> Verify that Scripts and Executables is selected
<Рис.> Убедитесь, что Scripts and Executables выбраны
4.  In the same Virtual Directory tab, click Configuration. In the Application Configuration dialog, click the App Mappings tab.

В той же вкладке Virtual Directory нажмите Configuration. В диалоге Application Configuration нажмите вкладку Application Configuration.
<fig> Verify that Cache ISAPI applications is selected.
           Verify that .asa and .asp are mapped to asp.dll
<Рис.> Убедитесь, что Cache ISAPI applications выбраны.
           Убедитесь, что.asa и .asp отображены к asp.dll 
5.  In the same Application Configuration dialog box, click the App Options tab.

В том же диалоговом окне Application Configuration нажмите вкладку App Options.
<fig> Select Enable session state and set the timeout interval
           Select Enable parent
           Click OK
<рис.> Выберите Enable session state и установите интервал времени ожидания
           Выберите Enable parent
           Нажмите OK
6.  In the Properties dialog box, click the Documents tab.

В диалоговом окне Properties нажмите вкладку Documents.
<fig> If necessary, add the Default.asp document to the list of documents...
           then remove any other documents and select Default.asp as the default
           Click to add the Default.asp document to the list
<Рис.> В случае необходимости, добавьте документ Default.asp к списку документов ...
           Затем удалите любые другие документы и выберите Default.asp как значение по умолчанию

           Щелкнитек, чтобы добавить документ Default.asp к списку
7.  In the same Properties dialog box, click the Directory Security tab. In the Anonymous Access and Authentication Control, click Edit to open the Authentication Methods dialog box.

В том же диалоговом окне Properties нажмите вкладку Directory Security. Anonymous Access and Authentication Control нажмите Edit, чтобы открыть диалоговое окно Authentication Methods.
<fig> Select Allow Anonymous Access.
           Then click Edit to define the anonymous user account
<рис.> Выберите Allow Anonymous Access.
           Затем нажмите Edit, чтобы определить учетную запись анонимного пользователя
8.  Define the anonymous user account:

Определите учетную запись анонимного пользователя:
<fig> Select the anonymous user account created on page 65.
           Clear Allow IIS to control password, and type the password
<рис.> Выберите учетную запись анонимного пользователя, созданную на странице 65.
           Очистите Allow IIS to control password и напечатайте пароль
9.  Click OK.

Нажмите OK.
10. Type the password in the Confirm Password dialog box, then click OK.

Напечатайте пароль в диалоговом окне Confirm Password, затем нажмите OK.
11. Click OK, then click OK again to close the Properties dialog.

Нажмите OK, затем нажмите OK снова, чтобы закрыть диалог Properties.
Editing the properties of the cache directory for IIS 5

Редактирование свойств каталога кэша для IIS 5
Edit the properties of the cache subdirectory as follows:

Редактируйте свойства подкаталога кэша следующим образом:
1. In the Internet Information Services left pane, navigate to the cache directory under the virtual directory name.

2. В левой области окна Internet Information Services перейдите к каталогу кэша под именем виртуального каталога.
3. Right-click the cache directory.

Щелкните правой кнопкой мыши каталог cache.
4. Click Properties from the shortcut menu.

Нажмите Properties в контекстном меню.
5. In the Properties dialog box, click the Directory tab.

В диалоговом окне Properties нажмите вкладку Directory.
6. Select the Read check box. Verify that no other options are selected.

Выберите переключатель Read. Убедитесь, что никакие другие параметры не выбраны.
7. For Execute Permissions, select None.

Для Execute Permissions выберите None.
8. Click OK.

Нажмите OK.
Edit the properties of the images directory for IIS 5

Редактирование свойств каталога изображений для IIS 5
Edit the properties of the images subdirectory as follows:

Редактируйте свойства подкаталога изображений следующим образом:
1. In the Navigator window of Internet Information Services, expand the directory tree of the Default Web Site until you locate the images directory under your alias name.

В окне Navigator в Internet Information Services разверните дерево каталогов Default Web Site, пока Вы не расположили каталог изображений под вашим условным именем.
2. Right-click the images directory.

Щелкните правой кнопкой мыши каталог images.
3. Click Properties from the shortcut menu.
Нажмите Properties в контекстном меню.
4. In the Properties dialog box, click the Directory tab.

В диалоговом окне Properties нажмите вкладку Directory.
5. Select the Read check box. Verify that no other options are selected.

Выберите переключатель Read. Убедитесь, что никакие другие параметры не выбраны.
6. For Execute Permissions, select None.

Для Execute Permissions выберитет None.
<fig> Select Read, and verify that the others are not selected.
           For Execute Permissions, select None
<рис.> Выберите Read и убедитесь, что другое не выбрано.
           Для Execute Permissions выберите None
7.  Click OK.

Нажмите OK.
Restart the web server for IIS 5

Перезагрузка сервера сети для IIS 5
Close Internet Information Services, saving your console settings, then restart the web server.

Закройте Internet Information Services, сохранив ваши пультовые параметры настройки, затем перезагрузите сервер сети.
You have completed installing and configuring the ClearQuest web server for IIS 5.

Вы завершили установку и компоновку сервера сети ClearQuest для IIS 5.
Enabling e-mail notification for web clients

Предоставление уведомления электронной почты для клиентуры сети
 ClearQuest clients use e-mail notification according to the business rules of your schema. To extend e-mail notification support to users of the web client, perform the following steps.

Клиентура ClearQuest использует уведомление электронной почты согласно деловым правилам вашей схемы. Чтобы расширить поддержку уведомления электронной почты пользователям клиентуры сети, выполните следующие шаги.
1. Copy the code below into a text editor.

Копируйте следующий код в редактор текста.
· For Windows NT,

Для Windows NT,
REGEDIT4

[HKEY_USERS\.DEFAULT\Software\Rational Software\ClearQue

st\<version>\SendMail]

"MailTransport"="Protocol"

"MAPIProfile"="MyMAPIProfile"

"SendActive"=dword:00000001

"SMTPHost"="MyMailHost"

"RealName"="Web Server On \\\\MyWebServerMachine"

"ReplyTo"=MyGenericReturnAddress@MyDomainName

· For Windows 2000,

Для Windows 2000,
Windows Registry Editor Version 5.00

[HKEY_USERS\.DEFAULT\Software\Rational Software\ClearQue

st\<version>\SendMail]

"MailTransport"="Protocol"

"MAPIProfile"="MyMAPIProfile"

"SendActive"=dword:00000001

"SMTPHost"="MyMailHost"

"RealName"="Web Server On \\\\MyWebServerMachine"

"ReplyTo"=MyGenericReturnAddress@MyDomainName

The <version> number represents the current ClearQuest software product version. To get this, start the ClearQuest Windows client GUI, point to Help > About, and note the value in the "Version:" field. If you have a service pack release, enter just the first token ("1.1" in this example).
Номер <версии> представляет текущую версию программного продукта ClearQuest. Чтобы получить его, запустите ClearQuest Windows client GUI в точке Help > About и заметьте значение в поле "Version:". Если Вы имеете сервисный выпуск модуля, введите только первый маркер ("1.1" в этом примере).
2. Edit the pertinent entries (MailTransport, MAPIProfile, SMTPHost, RealName, and ReplyTo) of the text in step 1 so that

Редактируйте подходящие входы (MailTransport, MAPIProfile, SMTPHost, RealName и ReplyTo) текста в шаге 1 таким образом
·  Protocol is either SMTP or MAPI

Protocol - SMTP или MAPI
·  MyMAPIProfile is the name of your MAPI profile (this value is ignored if MailTransport is set to anything other than MAPI)

MyMAPIProfile - название вашей конфигурации MAPI (это значение игнорируется, если MailTransport установлен иной, чем MAPI)
· MyMailHost is the name of your mail host computer if you are using SMTP

MyMailHost - имя вашей главной почты ЭВМ, если Вы используете SMTP
·  MyWebServerMachine is the name of your web server

MyWebServerMachine - имя вашего сервера сети
·  MyGenericReturnAddress@MyDomainName should be replaced by the return address to be used for notification mail messages sent by ClearQuest. This address should be a valid e-mail address on the mail server you are using.

MyGenericReturnAddress@MyDomainName должен быть заменен адресом возврата, который нужно использовать для сообщений уведомления почты, посланных ClearQuest. Этот адрес должен быть допустимым адресом электронной почты на сервере почты, который Вы используете.
3. Save the file using the following naming convention: <filename>.reg.

Сохраните файл, используя следующее соглашение об именах: < filename >.reg.
4. In Windows Explorer, navigate to the location where you saved the new file, then double-click it to import it to the registry.
В Windows Explorer перейдите к расположению, где Вы сохранили новый файл, затем дважды щелкните на нем, чтобы импортировать его в системный реестр.
Set up registry key access privileges

Установка привилегии доступа регистрации ключа 
 Give the anonymous user account full access privileges to the HKEY_USERS\.Default\Software\Rational Software\ClearQuest\<version>\SendMail registry key as follows.

Дайте учетной записи анонимного пользователя полные привилегии доступа HKEY_USERS\.Default\Software\Rational Software\ClearQuest\<version>\SendMail регистрации ключа  следующим образом.
For Windows NT,

Для Windows NT,
1. Select Run from the Start menu and type REGEDT32 to run the REGEDT32 program.

Выберите Run из меню Start и напечатайте REGEDT32, чтобы выполнить программу REGEDT32.
2. In the HKEY_USERS window, select .Default\Software\Rational Software\ClearQuest\<version>\SendMail.

В окне HKEY_USERS выберите .Default\Software\Rational Software\ClearQuest\<version>\SendMail.
3. On the Registry Editor menu bar, select Security > Permissions.

В строке меню Registry Editor выберите Security > Permissions.
4. Click Add to add the anonymous user account.

Нажмите Add, чтобы добавить учетную запись анонимного пользователя.
5. In the Add Users and Groups dialog box,

В диалоговом окне Add Users and Groups,
· If you chose the default local anonymous username, set List Names From to the name of the local machine and click Show users to view the list of domain accounts. Select the IUSR_machinename account from the Names list.

Если Вы выбрали заданное по умолчанию локальное анонимное имя пользователя, установите List Names From  к имени локальной машины и нажмите Show users, чтобы рассмотреть список учетов домена. Выберите учет IUSR_machinename из списка Names.
· If you are using a domain account, select that domain in the Look in field and click Show users to view the list of domain accounts. Select the domain account from the Name list.

Если Вы используете домен учета, выберите этот домен в поле Look in и нажмите Show users, чтобы рассмотреть список учетов домена. Выберите учет домена из списка Name.
6. Click Add.

Нажмите Add.
7. For the type of access, select Full Control.

Для типа доступа выберите Full Control.
8. Click OK.

Нажмите OK.
9. Select Replace Permission on Existing Subkeys so that the anonymous user can update the entire registry tree below ClearQuest.

Выберите Replace Permission on Existing Subkeys так, чтобы анонимный пользователь мог модифицировать полное дерево системных реестров ниже ClearQuest.
10. Click OK.

Нажмите OK.
11. Close the REGEDT32 program
Закройте программу REGEDT32
 For Windows 2000,

Для Windows 2000,
Give the anonymous user account full access privileges to the 

Дайте учетной записи анонимного пользователя полные привилегии доступа, 
HKEY_USER\.DEFAULT\Software\Rational Software\<version>\ClearQuest\SendMail registry key as follows.

чтобы регистрировать ключ следующим образом

1. Select Run from the Start menu and type REGEDT32 to run the REGEDT32 program.

Выберите Run из меню Start и напечатайте REGEDT32, чтобы выполнить программу REGEDT32.
2. In the HKEY_USER window, select .DEFAULT\Software\Rational Software\ClearQuest\<version>\SendMail.

В окне HKEY_USER, выберите .DEFAULT\Software\Rational Software\ClearQuest\<version>\SendMail.
3. On the Registry Editor menu bar, select Security > Permissions.

В строке меню Registry Editor выберите Security > Permissions.
4. Click Add.

Нажмите Add.
5. Select the anonymous user account.

Выберите учетную запись анонимного пользователя.
· If you chose the default local anonymous username in Step 2, set Look in to the name of the local machine, then select the <user_account> account from the Name list.

Если Вы выбрали заданное по умолчанию локальное анонимное имя пользователя в шаге 2,  установите Look in к имени локальной машины, затем выберите учет <user_account> из списка Name.
· If you are using a domain account, select that domain in the Look in field. Select the domain account from the Names list.

Если Вы используете домен учета, выберите этот домен в поле Look in. Выберите домен учета из списка Names.
6. Click Add.

Нажмите Add.
7. Click OK to close the dialog box.

Нажмите OK, чтобы закрыть диалоговое окно.
8. In the Permissions area, allow Full Control and Read permissions.

В области Permissions допустите Full Control и Read permissions.
9. Select Allow inheritable permissions from parent to propagate from this object.

Выберите Allow inheritable permissions from parent, чтобы передать от этого объекта.
10. Click Advanced.

Нажмите Advanced.
11. Select Reset permissions on all child objects...
Выберите Reset permissions on all child objects...
12. Click OK.
Нажмите OK.
13. Click Yes.

Нажмите Yes.
14. Click OK to close the Permissions for SendMail dialog box.

Нажмите OK, чтобы закрыть диалоговое окно Permissions for SendMail.
15. Close the REGEDT32 program.
Закройте программу REGEDT32.
Providing ClearQuest Web information to web clients

Обеспечение информация ClearQuest Web для клиентуры сети
 To enable your users to access ClearQuest over the web, tell them to enter the URL:

Чтобы дать возможность вашим пользователям обратиться к ClearQuest по сети, передайте, чтобы они ввели URL:
http://<host>/<alias>

where <host> is the host name of the ClearQuest Web server machine, and <alias> is the directory containing the ClearQuest Web files.

где <host > - имя главной машины ClearQuest Web server, и <alias > - каталог, содержащий файлы ClearQuest Web.
Using the Advanced Query editor

Использование редактора Advanced Query
 ClearQuest Web’s advanced query editor requires Java Runtime (JRE) plug-in. For Windows platforms, this plug-in is provided by ClearQuest Web if it is not already installed on the client machine. For Unix platforms, users are directed to the JavaSoft web site which may or may not have a download for the desired platform.

Редактор расширенного запроса ClearQuest Web требует сменного модуля Java Runtime (JRE). Для платформ Windows этот сменный модуль обеспечивается ClearQuest Web, если это уже не установлено на машине пользователя. Для платформ Unix, пользователи адресуются к информационному узлу JavaSoft, который может или не может иметь загрузку для желательной платформы.
Administrator note: The Java Runtime Environment is under active development by JavaSoft, and may not be available for all platforms. Consult the JavaSoft and Netscape web sites for details. On platforms where the JRE is not available, clients will not be able to use the Advanced Query Editor function of ClearQuest Web.

Примечание Администратора: Java Runtime Environment находится под активным развитием JavaSoft, и не может быть доступен для всех платформ. Консультируйтесь с информационными узлами JavaSoft и Netscape для получения подробностей. На платформах, где JRE не доступен, клиентура не сможет использовать функцию Advanced Query Editor в ClearQuest Web.
7. Upgrading ClearQuest

7. Обновление ClearQuest
 This chapter describes how to upgrade your existing ClearQuest installation. Before you begin the upgrade, read the release notes (\\ClearQuest\readme.html) to become familiar with what has changed in this release.

Эта глава описывает, как модернизировать вашу существующую инсталляцию ClearQuest. Прежде, чем Вы начнете обновление, прочитайте примечания к выпуску (\\ClearQuest\readme.html) чтобы ознакомиться с тем, что изменилось в этом выпуске.
Topics covered in this chapter include:

В эту главу включены разделы:
 “Understanding the upgrade process” on page 100

“Понимание процесса обновления” на странице 100
·  “Preparing to upgrade” on page 101

“Подготовка к модернизации” на странице 101
·  “Performing a test upgrade” on page 102

“Выполнение пробного обновления” на странице 102
·  “Performing the production upgrade” on page 107

“Выполнение промышленного обновления” на странице 107
·  “Upgrading clients” on page 108

“Обновление клиентуры” на странице 108
·  “Upgrading ClearQuest Web” on page 109

“Модернизация ClearQuest Web” на странице 109
Note: If you are using Rational ClearQuest/TeamTest Edition, see the Getting Started with Rational ClearQuest TeamTest Guide This guide is available as a Portable Document Format (PDF) file in the \\ClearQuest\books directory
Примечание: Если Вы используете Rational ClearQuest/TeamTest Edition, смотрите руководство Getting Started with Rational ClearQuest TeamTest. Это руководство  доступно как файл Portable Document Format (PDF) в каталоге  \\ClearQuest\books
Understanding the upgrade process

Понимание процесса обновления
 The following steps summarize the upgrade procedure. The sections of this chapter describe the steps in detail.

Следующие шаги суммируют процедуру обновления. Разделы этой главы описывают шаги подробно.
1. Read the ClearQuest release notes (\\Program Files\Rational\ClearQuest\readme.htm) to learn what has changed in this release.

Прочитайте примечания к выпуску ClearQuest (\\Program Files\Rational\ClearQuest\readme.htm), чтобы изучить, что изменилось в этом выпуске.
2. Read this chapter and be sure you understand the upgrade procedure before you begin.

Прочитайте эту главу и убеждитесь, что Вы понимаете процедуру обновления прежде, чем начнете работу.
3. Warning: Back up your current schema repository and user databases.

Предупреждение: Поддержите ваш текущий репозиторий схем и пользовательские базы данных.
4. Perform a test upgrade.

Выполните пробное обновление.
· Create new, empty vendor databases for your schema repository and user databases.

Создайте новые, пустые базы данных поставщика для вашего репозитория схем и пользовательских баз данных.
· Install the new version of ClearQuest.

Установите новую версию ClearQuest.
· Upgrade your schema with upgrade schema packages, if necessary.

Модернизируйте вашу схему с обновленными пакетами схем, в случае необходимости.
· Use the ClearQuest Maintenance Tool to upgrade your schema repository and user databases.

Используйте ClearQuest Maintenance Tool, чтобы модернизировать ваш репозиторий схем и пользовательских базы данных.
· Unlock your old databases so users can continue to work with those databases during the testing period.

Разблокируйте ваши старые базы данных, чтобы пользователи могли продолжать работать с этими базами данных в течение испытательного периода.
5. Perform the upgrade on your production databases.

Выполните обновление на ваших промышленных базах данных.
6. Notify your users of the new database connection information.

Уведомьте ваших пользователей относительно новой информации подключения базы данных.
Important: If you are using multiple products from the Rational Suite, all products must be from the same Suite version (installed from the same CD-ROM). If you want to upgrade a product from the Suite, uninstall all Rational Suite products and install the desired products from the newer Suite CD-ROM.
Важно: Если Вы используете множество программ из Rational Suite, все программы должны быть из одной и той же версии Suite (установлены с одного и того же CD-ROM). Если Вы хотите модернизировать программу из Suite, деинсталлируйте все программы Rational Suite и установите желаемые программы с более нового CD-ROM Suite.
Preparing to upgrade
Подготовка к модернизации
 The ClearQuest upgrade process upgrades the application and your databases. Because upgrading changes the underlying structure of your data and can change your schemas, we highly recommend the following:

Процесс обновления ClearQuest модернизирует приложение и ваши базы данных. Так как модернизация изменяет  глубинную структуру ваших данных и может изменить и ваши схемы, мы строго рекомендуем следующее:
· Do complete backups of your databases.

Выполните копии ваших баз данных.
Having a backup is the only way to be assured that you can recover your schemas and user data if something goes wrong during the upgrade process.

Наличие копии - единственный путь, который дает увереннность, что Вы сможете восстановить ваши схемы и информацию пользователя, если что-то пойдет не так как надо в течение процесса обновления.
· Do a test upgrade.

Выполните пробное обновление.
By testing the upgrade, you can be sure that your data upgrades successfully and your customizations work with the new release. Testing also gives you the chance to try new functionality in the form of Packages (for more information on packages, see the release notes).

Проверяя обновление, Вы можете убедиться, что ваши данные модернизируются успешно и ваши настройки работают с новым выпуском. Испытание также дает Вам шанс опробовать новые функциональные возможности в форме Packages (для получения дополнительной информации о пакетах, см. примечания к выпуску).
You should only upgrade your user databases when you completely understand the upgrade process and are sure the upgrade works with your customizations.

Вы должны модернизировать ваши базы данных пользователя только тогда, когда Вы полностью убедитесь, что  обновление срабатывает и обновления уверенно работают с вашими настройками.
Note: Upgrading might fail if you have custom database tables that were not created by ClearQuest. For information about upgrading if you have custom database tables, read the release notes (\\Program Files\Rational\ClearQuest\readme.htm).
Примечание: Обновление может потерпеть неудачу, если Вы имеете заказные таблицы базы данных, которые не были созданы ClearQuest. Для информации относительно обновления в случае, если Вы имеете заказные таблицы базы данных, прочитайте примечания к выпуску(\\Program Files\Rational\ClearQuest\readme.htm).
Performing a test upgrade

Выполнение пробного обновления
 We strongly recommend the following steps for performing a test upgrade. You should be sure the process works before upgrading your production databases.

Мы строго рекомендуем следующие шаги для выполнения пробного обновления. Перед обновлением ваших промышленных баз данных Вы должны убедиться, что процесс срабатывает.
Database locking
Блокировка базы данных
 To upgrade, install the latest version of ClearQuest, then use the ClearQuest Maintenance Tool to upgrade your databases. After ClearQuest upgrades your data, it locks your original databases. When your original databases are locked, you have two options for how to proceed with the upgrade:

Чтобы модернизировать, установите самую последнюю версию ClearQuest, затем используйте ClearQuest Maintenance Tool, чтобы модернизировать ваши базы данных. После того, как ClearQuest модернизирует ваши данные, он блокирует ваши первоначальные базы данных. Когда ваши первоначальные базы данных блокированы, Вы имеете две возможности продолжить обновление:
· You can complete the entire upgrading testing with the original databases locked.

Вы можете выпонить полное испытание обновления с первоначальными блокированными базами данных.
This means that your users will not be able to use ClearQuest until the upgrade testing is completed. How long that takes depends on the size and complexity of your database and the amount of testing you do. If the upgrade is successful, upgrade your client installations, and notify users about how to connect to the upgraded databases.

Это означает, что ваши пользователи не смогут использовать ClearQuest, пока испытание обновления не будет закончено. Сколько времени это займет, зависит от размера и сложности вашей базы данных, и количество испытаний, которые Вы проведете. Если обновление успешно, обновите ваши инсталляции клиента и уведомите пользователей относительно того, как соединиться с модернизированными базами данных.
· You can unlock your original databases while you test the upgrade. 

Вы можете разблокировать ваши первоначальные базы данных на то время, пока Вы проверяете обновление. 
This means that your users can continue to use your current version of ClearQuest and continue to enter records while the upgrade testing is performed. The only down time for your users occurs while the actual database upgrade and unlock procedures are being performed. If the upgrade test is successful, you must discard the test databases and perform the process again to upgrade the most current data.

Это означает, что ваши пользователи могут продолжать использовать вашу текущую версию ClearQuest и продолжать вводить записи во время выполнения испытания обновления. Единственное время простоя для ваших пользователей - это время, пока база данных фактическая модернизирует и разблокирует процедуры. Если испытание обновления успешно, Вы должны отбросить испытательные базы данных и выполнять процесс снова, чтобы модернизировать самые современные данные.
To unlock your original schema repository and user databases, see “Unlocking your original databases” on page 105.
Чтобы разблокировать ваш первоначальный репозиторий схем и пользовательские базы данных, см. “Разблокирование ваших первоначальных баз данных” на странице 105.
Upgrade steps
Шаги обновления
 The upgrade steps are the same whether you are performing a test upgrade or the final production upgrade. We highly recommend performing a test run. The following steps assume you are doing a test upgrade first.

Шаги обновления - одинаковы, выполняете ли Вы пробное обновление или заключительное промышленное обновление. Мы строго рекомендуем выполнять пробный запуск. Следующие шаги предполагают, что Вы сначала выполняете пробное обновление.
To perform an upgrade:

Чтобы выполнить обновление:
1. Back up your data.

Поддержите ваши данные.
Use your vendor tools to back up your schema repository and user databases. Upgrading changes the underlying structure of your data and can change your schemas. We strongly recommend you have a backup to revert to it if necessary. Install the latest version of ClearQuest on your test machine using the Administrator installation.

Используйте ваши инструментальные средства поставщика, чтобы поддержать ваш репозиторий схем и пользовательские базы данных. При обновлении изменяется глубинная структура ваших данных, и могут измениться ваши схемы. Мы строго рекомендуем, чтобы Вы имели копию, чтобы возвратиться к ней в случае необходимости. Установите самую последнюю версию ClearQuest на вашей испытательной машине, используя инсталляцию Administrator.
2. Create new, empty vendor databases for your schema repository and user databases. You should create the new databases in a new test directory or on a test server. For information on creating vendor databases see:

Создайте новые, пустые базы данных поставщика для вашего репозитория схем и пользовательских баз данных. Вы должны создать новые базы данных в новом испытательном каталоге или на испытательном сервере. Для информации относительно создания баз данных поставщика см.:
·  “Setting up Microsoft Access” on page 13

“Установка Microsoft Access” на странице 13
·  “Setting up SQL Anywhere” on page 14

“Установка SQL Anywhere” на странице 14
·  “Setting up Microsoft SQL Server Version 6.5” on page 19

“Установка Microsoft SQL Server Version 6.5” на странице 19
·  “Setting up Microsoft SQL Server 7 and 2000” on page 24

“Установка Microsoft SQL Server 7 and 2000” на странице 24
·  “Setting up the Oracle Server” on page 28

“Установка Oracle Server” на странице 28
Warning: Create empty databases only. Do not use your vendor database tools to move or copy the data. ClearQuest updates the data structure and moves it into the new databases as part of the upgrade process.

Предупреждение: Создайте только пустые базы данных. Не используйте ваши инструментальные средства базы данных поставщика, чтобы перемещать или копировать данные. ClearQuest модифицирует структуру данных и перемещает их в новые базы данных как партия процесса обновления.
3. Follow the installation steps in “Installing ClearQuest for an administrator” on page 37 to install the new version of ClearQuest.

Выполните шаги инсталляции из “Установка ClearQuest для администратора” на странице 37, чтобы установить новую версию ClearQuest.
4. Notify users to log off from ClearQuest, and shut down your web server.

Уведомьте пользователей, чтобы они вышли из ClearQuest, и выключите ваш сервер сети.
Users should not access ClearQuest during the upgrade process.

Пользователи не должны обращаться к ClearQuest в течение процесса обновления.
Note: Some high-end databases give the administrator a tool for logging users off from the database. Check your vendor database to see if it has such a tool.

Примечание: Некоторые продвинутые базы данных дают администратору инструмент для отключения пользователей от базы данных. Проверьте вашу базу данных поставщика, чтобы узнать, имеет ли она такой инструмент.
5. Upgrade your schema repository and user databases..104 Installing Rational ClearQuest

Модернизируйте ваш репозиторий схем и пользовательские базы данных.. 104  Инсталляция Rational ClearQuest
a.  Run the ClearQuest Maintenance Tool from the Start menu.

Запустите ClearQuest Maintenance Tool из меню Start.
b. Select the Upgrade schema repository and/or user database(s) and click Next.

Выберите Upgrade schema repository and/or user database(s), и нажмите Next.
c. Specify the schema repository to upgrade from (your existing production schema repository). Click Next.

Определите репозиторий схем для модернизации  из него (ваш существующий промышленный репозиторий схем). Нажмите Next.
d. To upgrade databases associated with this schema repository, select the Upgrade user databases option.

Чтобы модернизировать базы данных, связанные с этим репозиторием схем, выберите опцию Upgrade user databases.
e. Enter the ClearQuest login name and password for a ClearQuest user account with Super User privileges, then click Next.

Введите имя входящего в систему ClearQuest, и пароль для учетной записи пользователя ClearQuest с Super User privileges, затем нажмите Next.
f. Enter the schema repository to upgrade to (the new, empty database you created), then click Next.

Введите репозиторий схем, к которому будете  модернизировать  (новая, пустая база данных, которую Вы создали), затем нажмите Next.
g. For each of your user databases, enter the user database to upgrade to (the new, empty databases you created), then click Finish.

Для каждой из ваших пользовательских баз данных введите пользовательскую базу данных, к которой будете модернизировать (новые, пустые базы данных, которые Вы создали), затем нажмите Finish.
ClearQuest upgrades your schema repository and notifies you when the process is complete.

ClearQuest модернизирует ваш репозиторий схем и уведомляет Вас об окончании процесса.
6. Upgrade your schema by applying schema packages.

Модернизируйте вашу схему,  применяя пакеты схемы.
ClearQuest uses schema packages to add functionality to your schema. When you upgrade to a new version of ClearQuest, there are often "upgrade packages" that you’ll need to apply to your schema before deploying ClearQuest. See the release notes for which upgrade packages may be needed for your schema. For example, if you are upgrading from release 1.1 and had applied e-mail rule or integration add-ins, you must apply certain upgrade packages to your schemas.

ClearQuest использует пакеты схемы, чтобы добавить функциональные возможности к вашей схеме. Когда Вы модернизируете к новой версии ClearQuest, часто имеются "пакеты обновления", которые вы должны будете применить к вашей схеме перед развертыванием ClearQuest. См. примечания к тем выпускам, для которых пакеты обновления могут быть необходимы для вашей схемы. Например, если Вы модернизируете от выпуска 1.1 и применили правило электронной почты или надстройку интегрирования, Вы должны применить к вашим схемам некоторые пакеты обновления.
To add packages,

Чтобы добавить пакеты,
a. Start ClearQuest Designer.

Запустите ClearQuest Designer.
b. Choose View > Schema Summary to determine the packages that are currently applied to the schema.

Выберите View > Schema Summary, чтобы определить пакеты, которые в настоящее время применяются к схеме.
c. Refer to release notes to see which schema packages need to be upgraded.

Обратитесь к примечаниям к выпуску, чтобы увидеть, которые пакеты схемы должны быть модернизированы.
d. Choose Package > Package Wizard.
Выберите Package > Package Wizard.
e. Use the Package Wizard to apply packages. For more information, see packages, installing into a schema in the ClearQuest Designer Help Index.

Используйте Package Wizard, чтобы применить пакеты. Для получения дополнительной информации, см. пакеты, установкая в схему в оглавлении справочной системы ClearQuest Designer.
7. After upgrading your user databases to the new version of ClearQuest, you also need to upgrade them to use the latest version of the schema that incorporates the upgrade packages. For more information, see Working with Databases > Upgrading user databases in the ClearQuest Designer Help Contents tab.

После обновления ваших пользовательских баз данных к новой версии ClearQuest, Вы также должны модернизировать их, чтобы использовать самую последнюю версию схемы, которая включает пакеты обновления. Для получения дополнительной информации, см. Working with Databases > Upgrading user databases во вкладке ClearQuest Designer Help Contents.
8. Determine whether you want to unlock your original databases and allow users to continue working with ClearQuest during upgrade testing. If you choose to unlock the database, see “Unlocking your original databases” on page 105.

Определите, хотите ли Вы разблокировать ваши первоначальные базы данных и позволить пользователям продолжать работать с ClearQuest в течение испытания обновления. Если Вы решите разблокировать базу данных, см. “Разблокирование ваших первоначальных баз данных” на странице 105.
9. Test the application.

Тестирование приложения.
Enter a few test records and move them though your entire state model to be sure the upgrade is working correctly.

Введите несколько проверочных записей, и переместите их хотя бы к вашей полной модели состояний, чтобы убедиться, что обновление работает правильно.
Unlocking your original databases

Разблокирование ваших первоначальных баз данных
 If you choose to allow users to continue using your original databases while you test the upgrade, you must unlock the database.

Если Вы решили позволить пользователям продолжать использовать ваши первоначальные базы данных, в то время как Вы проверяете обновление, Вы должны разблокировать базу данных.
Note: After you perform the final upgrade, do not unlock your original databases. Keeping the original databases locked prevents your users from accessing the wrong databases.

Примечание: После того, как Вы закончите обновление, не разблокируйте ваши первоначальные базы данных. Сохранение первоначальных баз данных заблокированными не позволяет вашим пользователям доступ к неправильным базам данных.
1. Start a command window ("DOS prompt"), and change to the new ClearQuest home directory.
Запустите окно команды ("DOS prompt"), и изменитесь к новому основному каталогу ClearQuest.
2. To unlock the schema repository, type the command for your vendor database:

Чтобы разблокировать репозиторий схем, напечатайте команду для вашей базы данных поставщика:
> installutil unlockschemarepo dbvendor server db dbologin dbopassword ""

where:

где:
· dbvendor (vendor database) is either:

dbvendor (база данных поставщика) - также:
· SQL_SERVER for SQL Server databases

SQL_SERVER для баз данных SQL Server
·  MS_ACCESS for Microsoft Access

MS_ACCESS для Microsoft Access
·  SQL_ANYWHERE for Sybase SQL Anywhere

SQL_ANYWHERE для Sybase SQL Anywhere
·  ORACLE for Oracle

ORACLE для Oracle
·  server is either:

Сервер - также:
· the hostname of the SQL Server database server

имя главного сервера базы данных SQL Server
·  the SQL Anywhere database server name

имя сервера базы данных SQL Anywhere
·  the Oracle SQL*Net alias

условное имя Oracle SQL*Net 
·  an empty string (““) for Microsoft Access

пустая строка (““) для Microsoft Access
·  db is the database name containing your original schema repository for Oracle and SQL Server, or the full path to the database for Microsoft Access and SQL Anywhere

db - название базы данных, содержащей ваш первоначальный репозиторий схем для Oracle и SQL Server, или полного пути к базе данных для Microsoft Access и SQL Anywhere
·  dbologin is the userid that owns the database (use admin for Microsoft Access or SQL Anywhere)

dbologin – идентификатор пользователя, который имеет базу данных (используется администрацией для Microsoft Access или SQL Anywhere)
· dbopassword is the password to that userid (use admin for Microsoft Access or SQL Anywhere)

dbopassword - пароль к этому идентификатору пользователя (используется администрацией для Microsoft Access или SQL Anywhere)
3. To unlock user databases, repeat the above steps with the following exceptions:

Чтобы разблокировать пользовательские базы данных, повторите вышеупомянутые шаги со следующими исключениями:
· the installutil subcommand to use is unlockuserdb instead of unlockschemarepo

installutil команда подсистемы, чтобы использовать - unlockuserdb вместо unlockschemarepo
·  point to the server database containing the original user database, not the schema repository.

Пункт(точка) к базе данных сервера, содержащей первоначальную пользовательскую базу данных, но не репозиторий схем.
Performing the production upgrade

Выполнение промышленного обновления
 After you have performed a test upgrade and are comfortable with the process, you are ready to upgrade your production schema repository and user databases.

После того, как Вы выполнили пробное обновление и остались довольны процессом, Вы готовы модернизировать ваш промышленный репозиторий схем и пользовательские базы данных.
1. Determine if you need to perform the upgrade on your production database.

Определите, должны ли Вы выполнить обновление на вашей промышленной базе данных.
a. If you chose to leave your production database locked during testing and the test upgrade was successful, you can put your upgraded databases into production.

Если Вы решили оставить вашу промышленную базу данных блокированной в течение испытания, и пробное обновление прошло успешно, Вы можете ввести ваши модернизированные базы данных в производственный процесс.
b. If you choose to allow users to continue working with your production database during test, you need to repeat the upgrade process (see “Upgrade steps” on page 103), but this time you will not unlock your original databases.

Если Вы решили позволить пользователям продолжать работать с вашей промышленной базой данных в течение испытания, Вы должны повторить процесс обновления (см. “Шаги обновления” на странице 103), но на сей раз Вы не будете разблокировать ваши первоначальные базы данных.
Note: You will need to create new target databases before repeating the upgrade steps for production databases.

Примечание: Вы должны будете создать новые целевые базы данных перед повторением шагов обновления для промышленных баз данных.
2. Inform users of the new connection information to use when upgrading their client installations of ClearQuest.
Сообщите пользователям новую информацию подключения, чтобы они использовали ее при обновлении своих инсталляций ClearQuest client.
Upgrading clients
Обновление клиентуры
 Each client installation should be upgraded by uninstalling the current ClearQuest installation, installing the latest version of ClearQuest (see “Installing ClearQuest Windows for end-users” on page 51 and “Installing ClearQuest Unix client and Oracle Support” on page 57), and connecting to the newly upgraded databases.

Каждая инсталляция клиента должна быть модернизирована  деинсталляцией текущей инсталляции ClearQuest, установкой самой последней версии ClearQuest (см. “Установка ClearQuest Windows для конечных пользователей” на странице 51 и “Установка ClearQuest Unix client и Oracle Support” на странице 57), и соединением с заново модернизированными базами данных.
Note: Uninstalling the current version does not delete your databases or license information.

Примечание: Деинсталляция текущей версии не удаляет ваши базы данных или информацию лицензирования.
After upgrading, users who had enabled e-mail notification must reenable it. To do this:

После обновления, пользователи, которые допустили уведомление электронной почты, должны вновь допустить эту возможность. Чтобы сделать это:
1. Choose View > E-mail Options. This opens the E-mail Setup dialog.

Выберите View > > E-mail Options. Это открывает диалог E-mail Setup.
2. Select Enable E-mail Notification.

Выберите Enable E-mail Notification.
3. Select either SMTP or MAPI
Выберите SMTP или MAPI
4.  If you entered SMTP:

Если Вы ввели SMTP:
· Enter the SMTP host address of your mail server.

Введите адрес главного компьютера SMTP вашего сервера почты.
· Enter your e-mail address.

Введите ваш адрес электронной почты.
· Click Finish.

Нажмите Finish.
5. If you entered MAPI:

Если Вы ввели MAPI:
· Choose a MAPI profile from the list.

Выберите из списка конфигурацию MAPI.
· Click Finish.
Нажмите Finish.
Upgrading ClearQuest Web

Обновление ClearQuest Web
 To upgrade ClearQuest Web:

Чтобы модернизировать ClearQuest Web:
1. If you have not done so already, shut down your web server.

Если Вы этого еще не сделали, закройте ваш сервер сети.
2. Uninstall the current version and install the new version of ClearQuest on your Web server. See “Installing ClearQuest for an administrator” on page 37.

Деинсталлируйте текущую версию и установите новую версию ClearQuest на вашем сервере Web. См. “Установка ClearQuest для администратора” на странице 37.
3. Repeat all the steps in Chapter 6, “Setting Up ClearQuest Web” on page 63.

Повторите все шаги из Главы 6, “Установка ClearQuest Web” на странице 63.
4. Restart your web server.
Перезагрузите ваш сервер сети.
8. Лицензирование ClearQuest

This chapter gives an overview on how ClearQuest licenses work. The ClearQuest administrator sets up and maintains licenses using the Rational License Administrator.

Эта глава дает краткий обзор того, как ClearQuest лицензирует работу. Администратор ClearQuest устанавливает и обслуживает лицензии, используя Rational License Administrator.
For more information about licensing Rational Software products, see the book, “Administering Licenses for Rational Software”.
Для получения дополнительной информации относительно лицензирования продуктов Rational Software, см. книгу “Управлении лицензиями для Rational Software ”.
Working with Rational Software licensing

Работа с лицензированием Rational Software
 Rational Software product licensing provides two types of licenses:

Лицензирование продукта Rational Software обеспечивает два типа лицензий:
· Node-locked license: enables a single user to install and use a Rational Software product on a specific system.

Блокированная лицензия: дает возможность отдельному пользователю устанавливать и использовать продукт Rational Software на конкретной системе.

Floating license: enables a specified number of users to install and use a Rational Software product on their systems. Floating licenses are shared among all users of the licensed software.

Плавающая лицензия: дает возможность указанному числу пользователей устанавливать и использовать продукт Rational Software на их системах. Плавающие лицензии разделены среди всех пользователей лицензированного программного обеспечения.

Note: If you purchase ClearQuest with a node-locked license, your ClearQuest Web functionality is limited to the ability to submit defects and to run one query (predefined by your ClearQuest administrator). To get full ClearQuest Web functionality, you need to purchase a floating license.

Примечание: Если Вы купите ClearQuest с блокированной лицензией, ваши функциональные возможности ClearQuest Web будут ограничены по возможности представить дефекты и выполнить один запрос (предопределенный вашим ClearQuest администратором). Чтобы получить полные функциональные возможности ClearQuest Web, Вы должны купить плавающую лицензию.

The license key certificate included with your purchase of ClearQuest indicates the type of licenses you are working with and the license keys you need to install.

Сертификат ключа лицензии, включенный в ваш закупленный ClearQuest, указывает тип лицензий, с которой Вы работаете  и ключи лицензии, которые Вы должны установить.

Rational Software makes it easy to install and maintain licenses by providing the Rational License Administrator. Rational Software also provides GLOBEtrotter Inc.’s FLEXlm License Manager for administering floating licenses.

Rational Software облегчает инсталлирование и обслуживание лицензии,  обеспечивая Rational License Administrator. Rational Software также обеспечивает GLOBEtrotter Inc.’s FLEXlm License Manager для управления плавающими лицензиями.
The GLOBEtrotter Inc.’s FLEXlm License Manager is automatically installed when you install ClearQuest. To use the Rational License Administrator, select Rational ClearQuest > License Administrator from the Start menu. For information about installing your product licenses so you can get started using ClearQuest, see the Rational License Administrator online Help.

GLOBEtrotter Inc.’s FLEXlm License Manager автоматически устанавливается, когда Вы устанавливаете ClearQuest. Чтобы использовать Rational License Administrator, выберите Rational ClearQuest > License Administrator из меню Start. Для информации относительно установки вашего лицензионного продукта так, чтобы Вы могли начать использовать ClearQuest, см. интерактивную справку Rational License Administrator.

To install the FLEXlm License Manager, select GLOBEtrotter FLEXlm License Server from the list of products displayed in the Rational Software Setup program. For additional information about FLEXlm licensing, see the Rational License Administrator online Help.
Чтобы установить FLEXlm License Manager, выберите GLOBEtrotter FLEXlm License Server из списка продуктов, отображенного в программе Rational Software Setup. Для дополнительной информации относительно лицензирования FLEXlm, см. интерактивную справку Rational License Administrator.
9. Silent Installation of Rational ClearQuest

9. «Тихая» инсталляция Rational ClearQuest
 Silent Installation of Rational ClearQuest

You can configure Rational Software Setup to perform silent installations of Windows versions of Rational software. Silent installations allow you to perform an installation of a Rational Software product, using the same parameters, repeatedly on a number of systems.

Вы можете конфигурировать Rational Software Setup, чтобы выполнять тихие инсталляции версий Windows Rational software. Тихие инсталляции позволяют Вам выполнять инсталляцию Rational Software, используя одни и те же параметры, неоднократно в ряде систем.
The following sections provide a brief summary of the silent installation features.

Следующие разделы обеспечивают краткое резюме особенностей тихой инсталляции.

Note: We recommend you read Rational’s Silent Installation White Paper before you attempt a silent installation. The white paper is available from the Rational Web site at http://www.rational.com/. Select the following links in order: Technical Support, White papers, and Rational Suite.

Примечание: Мы рекомендуем, чтобы Вы прочитали Белую книгу Тихая инсталляция Rational прежде, чем Вы попытаетесь выполнить тихую инсталляцию. Белая бумага доступна узла из Rational Web в http://www.rational.com/. Выберите следующе в таком порядке: Техническая поддержка, Белые книги и Rational Suite.
Overview of Silent Installations of Rational ClearQuest

Краткий обзор тихих инсталляций Rational ClearQuest
 This section describes how to perform a silent install. The basic steps, explained below, are:

Этот раздел описывает, как выполнить тихую инсталляцию. Основные шаги, объясненные ниже:
1. Record an installation session.

Запишите сеанс инсталляции.
2. Optionally, add a post-installation command to the recorded installation.

Факультативно добавьте пост-инсталляционную команду к записанной инсталляции.
3. Execute the installation procedure.
Выполните процедуру инсталляции.
Recording a Software Installation of Rational ClearQuest

Запись программы инсталляции Rational ClearQuest
 You can record a software installation session and then use the responses that you provide to replay the installation. At the end of the recorded installation procedure, you will be given the option to exit without installing the product.

Вы можете сделать запись программного сеанса инсталляции и затем использовать ответы, которые Вы обеспечиваете, чтобы повторно запустить инсталляцию. В конце записи процедуры инсталляции, Вам будет дана опция, чтобы выйти без инсталляции продукта.
1. Insert the Rational ClearQuest software CD in a CD drive.

Вставьте Rational ClearQuest software CD в дисковод  CD.
2. Open a command window on your system and run RSSetup with the -autocapture switch. For example:

Откройте командное окно на вашей системе, и запустите RSSetup с переключателем - autocapture. Например:
<Install Location>\setup\rssetup -autocapture

Where <Install Location> is the location of the Rational ClearQuest software CD.

Где < Install Location > - расположение Rational ClearQuest software CD.
3. When the Rational Software Setup program starts, proceed with the installation procedure on “Understanding the install process” on page 9. Your responses will be recorded in the responses file which is named as follows:

Когда запустится программа Rational Software Setup, продолжите процедуру инсталляции в “Понимание процесса инсталляции” на странице 9. Ваши ответы будут зарегистрированы в файле ответов, который назван следующим образом:
<Install Path>\RSSetup\response.ini

Note: The option to use a temporary license is not supported when using the -autocapture switch. The silent installation procedure will not support the capture of license certificate information into the response.ini file.

Примечание: опция для использования временной лицензии не поддерживается при использовании переключателя - autocapture. Процедура тихой
 инсталляции не будет поддерживать сбор информации сертификата лицензии в файле response.ini.
4. After you have answered all of the questions related to the installation, you will be prompted to continue with the installation of the product or to exit from the setup program. Click OK to proceed with the installation or Cancel to exit. Even if you cancel at this point, your answers are still saved.

После того, как Вы ответили на все вопросы, связанные с инсталляцией, Вы получите запрос о продолжении инсталляции продукта или о выходе из установочной программы. Нажмите OK, чтобы  продолжить инсталляцию или Cancel, чтобы выйти. Даже если Вы отменяете в этом месте, ваши ответы все еще сохраняются.
Example

Пример
 The following example shows how to record an installation of Rational ClearQuest.

Следующий пример показывает, как делать запись инсталляции Rational ClearQuest.
<Install Location>\setup\rssetup -autocapture /product ClearQuest-1.1.
Specifying a Post-Installation Command

Определение пост-инсталляционной команды
 You can specify a command that will be performed after the silent installation has completed.

Вы можете определить команду, которая будет выполнена после того, как тихая инсталляция завершится.
After you have completed preparation for a silent installation, perform the following steps:

После того, как Вы завершили подготовку к тихой инсталляции, выполните следующие шаги:
1. Edit the response file. Append a line similar to the following to the end of the file. The label [PostInstallCmd] is required.

Редактируйте файл ответа. Добавьте строку, подобную следующей, к концу файла. Метка [PostInstallCmd] необходима.
 [PostInstallCmd]
Command=post-installation-commands.bat

where, the post-installation-commands.bat is a batch file that contains the commands you want to execute. Such a file might contain the following commands:

Где post-installation-commands.bat - пакетный файл, который содержит команды, которые Вы хотите выполнить. Такой файл может содержать следующие команды:
licadmin -fserver.txt
net send administrator “Installation Complete”

In this example, the License Key Administrator, licadmin, starts and uses the information in server.txt to specify the name of the license server that the current system will use. The batch file then sends a message to the administrator, indicating that the installation procedure is complete.

В этом примере License Key Administrator, licadmin, запускается и использует информацию в server.txt, чтобы определить имя сервера лицензии, который существующая система будет использовать. Пакетный файл затем посылает сообщение администратору, указывая, что процедура инсталляции закончена.
2. Save the response file to a unique name (to ensure that is it not overwritten by subsequent autocaptures). For example, save the response file with a name such as c:\responses\ent-w-post.ini.
3. Сохраните файл ответа с уникальным именем (чтобы гарантировать, что  он не запишется поверх последующими автосборами данных). Например, сохраните файл ответа с именем типа c:\responses\ent-w-post.ini.
Performing a Silent Software Installation

Выполнение тихой инсталляции программы 
 After you have recorded your responses, use the response file to replay the installation. For example:

После того, как Вы записали ваши ответы, используйте файл ответа, чтобы повторно запустить инсталляцию. Например:
<Install Location>\setup\rssetup –silent
-response:response-path

Where response-path is the path of the response file. The default path is as follows:

"c:\Program Files\Rational\RSSetup\response.ini"

Note: If a response file is in the default location, that response file will be used each time you run the installation procedure. Specifying a response file, using the -response:response-path parameter, will override the default response file.

Примечание: Если файл ответа находится в заданном по умолчанию расположении, этот файл ответа будет использоваться каждый раз,  когда Вы выполняете процедуру инсталляции. Определение файла ответа с  использованием параметра  -response:response-path отменит заданный по умолчанию файл ответа.
If you specify -autocapture on the RSSetup command line, your installation will initially select the product name identified in the previous response.ini file, but will allow you to select a new product for installation. A new response.ini file will be saved at the end of the installation procedure.

Если Вы определяете - autocapture на командной строке RSSetup, ваша инсталляция первоначально выберет имя продукта, идентифицированное в предыдущем файле  response.ini, но позволит Вам выбрать новый продукт для инсталляции. Новый файл response.ini будет сохранен в конце процедуры инсталляции.
Preparing Multiple Response Files

Подготовка многократных файлов ответа
 You can save multiple response files to support attended installation of different products.

Вы можете сохранять многократные файлы ответа, чтобы поддержать сопровождаемую инсталляцию различных продуктов.
1. Identify a directory where you will store your response files. The following examples use a directory named as follows:

Идентифицируйте каталог, где Вы сохраните ваши файлы ответа. Следующие примеры используют каталог, названный следующим образом:
C:\responses

2. Record the response file for each product you want to install.

Запишите файл ответа для каждого продукта, который Вы хотите установить.
3. Rename the response file with a unique file name. For example, save the ClearQuest 2.0 response file as
C:\responses\ClearQuest2_0responses.ini.

Переименуйте файл ответа с уникальным именем файла. Например, сохраните  файл ответа ClearQuest 2.0 как
 C:\responses\ClearQuest2_0responses.ini. 
4. Perform the installation and specify the path to the response file as a parameter to the -response switch. For example:

Выполните инсталляцию и определите путь к файлу ответа как параметр для выключателя - response. Например:
<Install Location>\setup\rssetup –silent
-response:c:\response\ClearQuest2_0response.ini.
Examples

Примеры
 See “Silent Installation of Rational ClearQuest” on page 113.

См. “Тихая инсталляция Rational ClearQuest” на странице 113.
To record an installation of Rational ClearQuest version 2.0:

Чтобы записать инсталляцию версии 2.0 Rational ClearQuest:
<Install Location>\setup\rssetup -autocapture /product ClearQuest-2.0

To remove Rational ClearQuest version 2.0:

Чтобы удалить версию 2.0 Rational ClearQuest:
<Install Location>\setup\rssetup /uninstall /product ClearQuest-2.0.
RSSetup Command Syntax

Синтакс команд RSSetup
 This section provides the syntax for RSSetup, and well as a table of RSSetup command parameters.

Этот раздел обеспечивает синтаксис для RSSetup и таблицу параметров команды RSSetup.
Syntax

Синтаксис
 RSSetup [-silent [-response:response-path]]|
        [-verbose [-response:response-path]] |
        [-autocapture]
        [/product <product>] [/install /uninstall /update]

	RSSetup Command Parameter
Параметр команды RSSetup
	Description
Описание

	-silent
	Performs a silent (unattended) installation.
Выполняет тихую (автоматическую) инсталляцию.

	-verbose
	Replays a previously recorded installation, allowing you to override the recorded responses.

Повторно запускает предварительно зарегистрированную инсталляцию, позволяя Вам отменить зарегистрированные ответы.
Note: if you override the responses, those changes are not written to the response file.
Примечание: если Вы отменяете ответы, эти изменения не записываются к файлу ответа.

	-response:response-path
	Specifies the path to the response file. response-path is the path for the response file. You must specify the response-path.

Определяет путь к файлу ответа. Путь ответа - путь для файла ответа. Вы должны определить путь ответа.
The default path is <Install Location>\Setup\ RSSetup\response.ini, where <Install Location> is the location of the installation files.
Заданный по умолчанию путь - < Install Location>\Setup\ RSSetup\response.ini, где < Install Location > - расположение инсталляционных файлов.

	-autocapture
	Records your responses to a software installation, storing the responses in a file for later replay.
Записывает ваши ответы на инсталляцию программы, сохраняя ответы в файле для более позднего использования.

	/product product-identifier
	Specifies the product you are installing. This parameter does not apply for silent installations. For a silent installation, you specify the product name in the response file. See page 119 for the list of identifier you can use with this switch.
Определяет продукт, который Вы устанавливаете. Этот параметр не применяется для  тихих инсталляций. Для тихой инсталляции Вы определяете имя продукта в файле ответа. См. страницу 119 для списка идентификаторов, которые Вы можете использовать с этим выключателем.

	/install
	Installs the product you specified with the /product switch.

Инсталлирует продукт, который Вы определили с / product switch.
This switch cannot be combined with /uninstall or /update. This parameter does not apply for silent installations. For a silent installation, you specify the product name in the response file.
Этот выключатель не может быть объединен с / uninstall или /update. Этот параметр не применяется для  тихих инсталляций. Для тихой инсталляции Вы определяете имя продукта в файле ответа.

	/uninstall
	Removes the product you specified with the /product switch.

Удаляет продукт, который Вы определили с /product switch.
This switch cannot be combined with /install or /update.
Этот выключатель не может быть объединен с /install или /update. 

	/update
	Updates the product you specified with the /product switch.

Модифицирует продукт, который Вы определили с /product switch.
This switch cannot be combined with /install or /uninstall.

Этот выключатель не может быть объединен с /install или /uninstall.
This parameter does not apply for silent installations.
Этот параметр не применяется для  тихих инсталляций.


The table below lists the product identifiers you must use with the /product switch.

Таблица ниже перечисляет идентификаторы продукта, которые Вы должны использовать с /product switch.
	Product Name Product 
	Identifiers

	Rational LoadTest 
	atbuLoadTest

	Rational Suite Performance Studio Agent
	atbuPSAgent

	Rational Suite Performance Studio 
	atbuRSuitePerformanceStudio

	Rational Test Enablers 
	atbuSetupEnablers

	Rational TeamTest 
	atbuTeamTest

	Rational TestAccelerator 
	atbuTestAccelerator

	Rational Robot 
	atbuTSRobot

	Rational ClearQuest 
	ClearQuest-1.1

	Rational ClearQuest TeamTest Edition 
	ClearQuestTeamTestEdition-1.1

	Rational PureCoverage 
	coverageNT

	Rational Suite DevelopmentStudio for UNIX
	dsbuRSDSU

	Rational Developer Kit 
	dsbuDeveloperKit

	Rational Purify 
	purifyNT

	Rational Quantify 
	quantifyNT

	Rational RequisitePro 
	rmbuRequisitePro

	Rational RequisiteWeb 
	rmbuRequisiteWeb

	Rational Rose Inline EJB Addin 
	Inline

	Rational Rose Enterprise Edition 
	Rose98i

	Rational Rose Professional C++ Edition
	Rose98iC++Professional

	Rational Rose Professional J Edition 
	Rose98iJavaProfessional

	Rational Rose Modeler Edition 
	Rose98iModeler

	Rational Rose Professional Visual Basic Edition
	Rose98iVBProfessional

	Rational Rose Professional Data Modeler Edition
	RoseDataModelerProfessional

	Rational Unified Process 
	ruObjectory51

	Rational SoDA for Word 
	SoDA

	Rational Suite AnalystStudio 
	wsbuAnalystEdition

	Rational Suite DevelopmentStudio 
	wsbuDevelopmentStudio

	Rational Suite Development Studio - RealTime Edition
	wsbuDevelopmentStudioRT

	Rational Suite Enterprise 
	wsbuEnterprise

	Globetrotter FLEXlm License Server 
	wsbuFLEXlmServer

	Sybase SQL Anywhere Database Server
	wsbuSQLAnywhereServer

	Rational Suite TestStudio 
	wsbuTestStudio

	Rational Suite Web Server Components
	wsbuWebComponents


License Key Administrator Command Line

Командная строка License Key Administrator

 You can run the Rational License Key Administrator from a command line or batch file to automate your license key installations and configuration.

Вы можете выполнять Rational License Key Administrator из командной строки или пакетного файла, чтобы автоматизировать ваши инсталляции лицензии ключа и конфигурацию.
Additional detailed information about the License Key Administrator command line options and usage is available on the Rational Suite web site:

Дополнительная детальная информация относительно параметров командной строки License Key Administrator и использования доступна на информационном узле Rational Suite:
http://www.rational.com/products/rs/prodinfo/index.jtmpl.

License Key Administrator Syntax

Синтаксис License Key Administrator
 licadmin -ffilename.ext
Table 1: Licadmin Command Parameters
Таблица 1: Параметры команды Licadmin
	Parameter
Параметр
	Description
Описание

	-ffilename.ext
	Specifies the path to the license parameter file. The license parameter file specifies the name of the license key server that you will use. For example:

Определяет путь к файлу параметра лицензии. Файл параметра лицензии определяет имя сервера ключа лицензии, который Вы будете использовать. Например:
Server:group-license-server

The keyword Server is case-sensitive.
Ключевое слово Server
чувствительно к регистру.


The status of the execution of this command is written to a file named filename.ext_STATUS, where filename.ext is the name of the license parameter file you used. The status file is created in the directory where you executed the licadmin command.

Состояние выполнения этой команды написано к файлу, именованному filename.ext_STATUS, где filename.ext - имя файла параметра лицензии, который Вы используете. Файл состояния создан в каталоге, где Вы выполняли команду licadmin.
Example

Пример
1.  Create a file that contains the following line:

Создайте файл, который содержит следующую строку:
Server:group-license-server

where group-license-server is the name of your FLEXlm License Server system.

Где  group-license-server  имя вашей системы FLEXlm License Server.
2. Save the file as server-info.txt.

Сохраните файл как server-info.txt.
3. In a command window, run the following command:

В окне команды выполните следующую команду:
licadmin -fserver-info.txt

Your system will be configured to use floating license keys from group-license-server.

Ваша система будет конфигурирована для использования ключей плавающей  лицензии из  group-license-server.
1

_1048943517

_1048943573

_1048943358

